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WF-6090 User's Guide
Welcome to the WF-6090 User's Guide.
For a printable PDF copy of this guide, click here.
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Product Basics
See these sections to learn about the basic features of your product.

Note: Printing software instructions in this manual are intended for use with the standard Epson printer
software. For more information on using the Printer Command Language (PCL) or PostScript (PS3)
printer software, please see the appropriate sections.

Using the Control Panel
Product Parts Locations
Using Eco Mode
Epson Connect Solutions for Smartphones, Tablets, and More
Using AirPrint
Using Google Cloud Print
Printing with NFC from Your Android Device

Using the Control Panel
See these sections to learn about the control panel and select control panel settings.
Control Panel Buttons and Lights
Setting a Password and Locking the Control Panel
Changing LCD Screen Language
Adjusting the Screen Contrast
Parent topic: Product Basics
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Control Panel Buttons and Lights

1 The power button and light
2 The Paper Setup button
3 The Error light
4 The Data light
5 The LCD screen
6 The Back button
7 The arrow buttons and the OK button
8 The Stop button

Status Icons
Parent topic: Using the Control Panel

Status Icons
Status icons may be displayed on the LCD screen depending on the product's status.

Icons Description
There is no Ethernet connection.
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Icons Description
An Ethernet connection has been established.

A Wi-Fi network error has occurred or the product is searching for a connection.

A Wi-Fi connection has been established. The number of bars indicates the
connection's signal strength.
An Ad hoc connection has been established.

A Wi-Fi Direct mode connection has been established.

A Simple AP mode connection has been established.

One of the Eco Mode settings is enabled.

Parent topic: Control Panel Buttons and Lights

Setting a Password and Locking the Control Panel
You can set an administrator password to lock the following control panel settings:
• System Administration Setup settings
• Eco mode settings
When the control panel is locked, you must enter the password to access any of the locked settings.
1. Press the arrow buttons to select Menu and press the OK button.

You see a screen like this:
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2. Select Admin Settings and press the OK button.
3. Select Admin Password and press the OK button.
4. Select Register and press the OK button.

You see a screen like this:

5. Use the control panel buttons to enter a password and press the OK button.
6. Enter your password again to confirm.
7. Press the OK button.
8. Select Lock Setting and press the OK button.
9. Select On and press the OK button.

Note: If you forget your password, contact Epson support for assistance.

Entering Characters on the LCD Screen
Parent topic: Using the Control Panel
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Entering Characters on the LCD Screen
Follow these guidelines to enter characters for passwords and other settings.

• To enter letters or symbols, press the up or down arrow buttons to scroll through characters, and press
the right arrow button to select one.

• To enter numbers or change the case of letters, press the Stop button.
• To delete the previous character, press the left arrow button.
• To enter a space, press the right arrow button.
Parent topic: Setting a Password and Locking the Control Panel

Changing LCD Screen Language
You can change the language used on the LCD screen.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the arrow buttons to select Menu and press the OK button.
2. Select System Administration and press the OK button. Enter the administrator password, if

necessary.
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You see a screen like this:

3. Select Common Settings and press the OK button.
4. Select Language and press the OK button.
5. Select a language and press the OK button.
Parent topic: Using the Control Panel

Adjusting the Screen Contrast
You can adjust the contrast of the LCD screen.
1. Press the arrow buttons to select Menu and press the OK button.
2. Select System Administration and press the OK button. Enter the administrator password, if

necessary.
You see a screen like this:

3. Select Common Settings and press the OK button.
4. Select LCD Contrast and press the OK button.
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5. Press the up or down arrow buttons to adjust the screen contrast.
6. Press the OK button to exit.
Parent topic: Using the Control Panel

Product Parts Locations
See these sections to identify the parts on your product.
Product Parts - Front
Product Parts - Inside
Product Parts - Back
Parent topic: Product Basics

Product Parts - Front

1 Front paper feed slot edge guides
2 Front paper feed slot (B2)
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3 Paper cassette 1 (C1)
4 Optional paper cassettes 2 and 3 (C2 to C3)

1 Rear paper feed edge guides
2 Paper support
3 Rear paper feed slot (B1)
4 Feeder guard
5 Output tray
6 Paper cassette edge guides

19



7 Paper cassette

Parent topic: Product Parts Locations

Product Parts - Inside

1 Control panel
2 Print head
3 Front cover (A); opened
4 NFC (Near Field Communications) tag

Parent topic: Product Parts Locations
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Product Parts - Back

1 Rear cover 2 (D2)
2 AC inlet
3 Rear cover 1 (D1); opened
4 Rear cover (E)
5 Service USB port (do not remove sticker)
6 USB port
7 LAN port

Parent topic: Product Parts Locations

Using Eco Mode
Your product enters sleep mode automatically and turns off the LCD screen if it is not used for a period
of time. You can make the time period shorter and select other options to save energy and resources.
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Changing the Eco Settings
Changing the Sleep Timer Settings
Changing the Power Off Timer Settings
Parent topic: Product Basics

Changing the Eco Settings
You can use the product control panel to change the Eco settings.

Note: The Sleep Timer setting in Eco Mode overrides the Sleep Timer setting in Common Settings. This
setting can be locked by an administrator. If you cannot access or change this setting, contact your
administrator for assistance.

1. Press the arrow buttons to select Menu and press the OK button.
2. Select System Administration and press the OK button. Enter the administrator password, if

necessary.
3. Select Eco Mode and press the OK button.

You see a screen like this:

4. Select On and press the OK button.
5. Press the up arrow button.
6. Change settings as necessary.
7. Press the OK button to exit.

You see the icon on the LCD screen to indicate that Eco settings are enabled.
Parent topic: Using Eco Mode
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Related tasks
Changing the Sleep Timer Settings

Changing the Sleep Timer Settings
You can adjust the time period before your product enters sleep mode and turns off the LCD screen.

Note: The Sleep Timer setting in Eco Mode overrides the Sleep Timer setting in Common Settings. This
setting can be locked by an administrator. If you cannot access or change this setting, contact your
administrator for assistance.

1. Press the arrow buttons to select Menu and press the OK button.
2. Select System Administration and press the OK button. Enter the administrator password, if

necessary.
3. Select Common Settings and press the OK button.
4. Select Sleep Timer and press the OK button.

You see a screen like this:

5. Press the up or down arrow button to increase or reduce the number of minutes.
6. Press the left or right arrow button to move the cursor.
7. Press the OK button to exit.
Parent topic: Using Eco Mode
Related tasks
Changing the Eco Settings
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Changing the Power Off Timer Settings
You can have the product turn off automatically if it is not used for a specified period of time.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the arrow buttons to select Menu and press the OK button.
2. Select System Administration and press the OK button. Enter the administrator password, if

necessary.
You see a screen like this:

3. Select Common Settings and press the OK button.
4. Select Power Off Timer and press the OK button.
5. Select a time period between 30minutes and 12h (12 hours), and press the OK button.
Parent topic: Using Eco Mode

Epson Connect Solutions for Smartphones, Tablets, and More
You can print documents, photos, emails, and web pages from your home, office, or even across the
globe. You can use your smartphone, tablet, or computer. Epson offers these solutions to print from
anywhere: Epson Email Print, Epson iPrint Mobile App, and Epson Remote Print.
Using Epson Email Print
Using the Epson iPrint Mobile App
Using Epson Remote Print
Parent topic: Product Basics
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Related topics
Wi-Fi or Wired Networking

Using Epson Email Print
With Epson Email Print, you can print from any device that can send email, such as your smartphone,
tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a
PDF, Microsoft Office document, or photo to an email and send it to your product.
1. Set up your product for network printing. See the link below.
2. If you did not already set up Email Print when you installed your product software, visit

epson.com/connect to learn more about Email Print, check compatibility, and get detailed setup
instructions.

3. Send an email with attachments to your product's Email Print address.

Note: Both the email and any attachments print by default. You can change these printing options by
logging into your Epson Connect account.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related topics
Wi-Fi or Wired Networking

Using the Epson iPrint Mobile App
Use this free Apple and Android app to print to nearby Epson networked products. The Epson iPrint
Mobile App lets you print PDFs, Microsoft Office documents, photos, and web pages over a wireless
network.
1. Set up your product on a network. See the link below.
2. Visit epson.com/connect to learn more about Epson iPrint and check the compatibility of your mobile

device.
3. Download Epson iPrint from the Apple App Store or Google Play.
4. Connect your mobile device to the same wireless network that your product is using.
5. Print from your mobile device to your Epson product.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related topics
Wi-Fi or Wired Networking
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Using Epson Remote Print
With Epson Remote Print software, you can print to an Epson Email-enabled product anywhere in the
world.
1. Set up your product for network printing. See the link below.
2. Visit epson.com/connect to learn more about Remote Print and how to download the software.
3. Download and install the Remote Print software.
4. Obtain the email address and optional access key of the Epson product you want to use for printing,

and enter this address during Remote Print setup.
5. Select the print command in your application and choose the Remote Print driver for your Epson

product.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related topics
Wi-Fi or Wired Networking

Using AirPrint
AirPrint enables instant wireless printing from iPhone, iPad, and iPod touch with the latest version of
iOS, and Mac with the latest version of OS X.

1. Load paper in your product.
2. Set up your product for wireless printing. See the link below.
3. Connect your Apple device to the same wireless network that your product is using.
4. Print from your device to your product.

Note: For details, see the AirPrint page on the Apple website.

Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking
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Using Google Cloud Print
With a Google Account, you can print from your Apple or Android device to your Epson product. You can
also print from Chromebooks and the Google Chrome browser without drivers or cables.
Set up your Epson product for network printing. See the link below.

Note: Make sure your Epson printer and computer are connected to the same network before starting
the Google Cloud Print setup.

1. Connect your device to the same network that your Epson product is using.
2. Print a network status sheet.
3. Locate your product's IP address on the network status sheet.
4. Enter the IP address into the address bar of a web browser.
5. Select the Google Cloud Print Services option.

Note: If you don't see the Google Cloud Print Services option, turn your product off and back on. If
the option still doesn't appear, select the Firmware Update option and follow the on-screen
instructions to update your product.

6. Click Register.
7. Select the checkbox to agree to the Usage Advisory and click Next.
8. Click OK to launch the sign-in page.

A separate browser window opens.
9. Enter your Google Account username and password and click Sign in, or, if you don't have an

account, click Sign up for a new Google Account and follow the on-screen instructions.
10. Click Finish printer registration to complete setup and print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook,
computer, Apple or Android device with Internet access. Visit Epson Support for more information on
using Google Cloud Print, or the Google Cloud Print website for a list of supported apps.

Setting Up Google Cloud Print on a Chromebook
Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking
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Setting Up Google Cloud Print on a Chromebook
With a Google Account, you can print from a Chromebook without drivers or cables.
Set up your Epson product for network printing. See the link below.

Note: Make sure your Epson product is connected to your wireless network before starting the Google
Cloud Print setup.

1. Turn on your Chromebook and connect it to the same wireless network as your product.

Note: See your Chromebook's documentation for details on connecting to a network.

2. Do one of the following:
• Click Add to Cloud Print in the notification that appears in the corner of your Chromebook

screen.

Note: If you do not see a notification, check to see if a number appears in the status area at the
lower-right corner of the screen. Click this number to open the notifications menu, then click Add
to Cloud Print.

• Open a web browser and enter chrome://devices in the address bar. Skip to step 4.
• If you see a registration confirmation screen instead, click Register.

3. Click Add Device.
4. Click the Register button that appears next to your product.
5. Click Register on the confirmation screen. Your product's LCD screen displays a confirmation

message.
6. Select OK or press the OK button on your product to confirm the Google Cloud Print connection and

print a test page.
Your product is now linked to your Google Account and can be accessed from any Chromebook,
iPhone, or Android phone with Internet access. For more information on using Google Cloud Print,
visit Epson Support.

Parent topic: Using Google Cloud Print
Related topics
Wi-Fi or Wired Networking
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Printing with NFC from Your Android Device
You can easily connect your Android 4.0 or later device to your product using NFC (Near Field
Communication). Once connected, you can print using Epson iPrint.
1. Make sure Epson iPrint is installed on your mobile device.
2. Make sure Simple AP mode is enabled on your printer, that you are using the default Wi-Fi Direct

password, and that paper is loaded in the product.

Note: NFC printing will not work if you changed the Wi-Fi Direct password from the default.

3. Touch the NFC antenna of your mobile device to the NFC tag on your product.

Note: If you do not see the NFC logo on your product, your administrator may have disabled NFC.
The location of your mobile device's NFC antenna varies. See your mobile device documentation for
more details.

Epson iPrint opens.
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Note: If you do not have Epson iPrint installed, the app store page for the Epson iPrint app opens.
Install Epson iPrint and repeat this step.

4. Touch the NFC antenna of your mobile device to the product NFC tag on your product again.
The printer and mobile device connect.

Note: If the mobile device and product disconnect, try to print a document. The mobile device and
product should reconnect automatically.

5. Open the file you want to print in Epson iPrint.
6. Touch the NFC antenna of your mobile device to the NFC tag on your product to start printing.
Parent topic: Product Basics
Related references
Status Icons
Related tasks
Enabling Wi-Fi Direct Mode
Related topics
Loading Paper
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Wi-Fi or Wired Networking
See these sections to use your product on a Wi-Fi or wired network.
Wi-Fi Infrastructure Mode Setup
Wi-Fi Direct Mode Setup
Wi-Fi Protected Setup (WPS)
Printing a Network Status Sheet
Changing or Updating Network Connections

Wi-Fi Infrastructure Mode Setup
You can set up your product to communicate with your computer using a wireless router or access point.
The wireless router or access point can be connected to your computer over a wireless or wired network.

1 Epson product
2 Wireless router or access point
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3 Computer with a wireless interface
4 Computer
5 Internet
6 Ethernet cable (used only for wired connection to the wireless router or access point)

Selecting Wireless Network Settings From the Control Panel
Parent topic: Wi-Fi or Wired Networking

Selecting Wireless Network Settings From the Control Panel
You can select or change wireless network settings using your product control panel.
To install your product on a wireless network, follow the instructions on the Start Here sheet and install
the necessary software. The installer program guides you through network setup.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not
responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your network data and settings.

1. Press the arrow buttons to select Wi-Fi Setup and press the OK button.
You see this screen:

2. Select Wi-Fi Setup Wizard and press the OK button.

Note: If you need to disable the wireless network to set up your product on an Ethernet network,
press the down arrow button, select Disable Wi-Fi, and press the OK button. Then follow the
instructions on changing to a wired network connection in this guide.
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3. Select the name of your wireless network and press the OK button.

Note: To enter the wireless network name manually, select Other Networks and press the OK
button. Use the printer's buttons to enter your network name.

4. Enter your wireless password using the control panel buttons.

Note: The network name and password are case sensitive. Be sure to correctly enter uppercase and
lowercase letters, and numeric or special characters.

• To enter letters or symbols, press the up or down arrow buttons to scroll through characters, and
press the right arrow button to select one.

• To enter numbers or change the case of letters, press the Stop button.
• To delete the previous character, press the left arrow button.
• To enter a space, press the right arrow button.

5. Press the OK button when you’re finished entering your password.
6. Confirm the displayed network settings and press the OK button to save them.

Note: If you need to change a setting, press the Back button.

7. If you want to print a network setup report, press the down arrow button, select Print connection
report, and press the OK button. (Otherwise, press the OK button.)
If the Wi-Fi connection symbol isn't lit or does not appear on the LCD screen, you may have selected
the wrong network name or entered the password incorrectly. Repeat these steps to try again.

Parent topic: Wi-Fi Infrastructure Mode Setup
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Related references
Status Icons

Wi-Fi Direct Mode Setup
You can set up your product to communicate directly with your computer or another device without
requiring a wireless router or access point.

1 Epson product
2 Computer with a wireless interface
3 Other wireless device

You can select one of these modes to communicate with your computer or device:
Access point mode

The product itself acts as the network access point for up to 4 devices. When operating in this mode,
your product displays an AP connection symbol on the LCD screen.

Peer-to-peer mode
The product communicates one-to-one with another Wi-Fi Direct capable device. When operating in
this mode, your product displays a Direct or D connection symbol on the LCD screen.
To disconnect a peer-to-peer mode connection, release the connection to your product from your
computer or other device.
To enable peer-to-peer mode, you must select it from the Web Config Utility, under WiFi/Network
Settings > Services > Wi-Fi Direct.

34



Enabling Wi-Fi Direct Mode
Changing the Wi-Fi Direct Password
Parent topic: Wi-Fi or Wired Networking
Related references
Status Icons

Enabling Wi-Fi Direct Mode
You can enable Wi-Fi Direct mode to allow direct communication between your product and a computer
or other devices without a wireless router or access point.

Note: You may need to enable the Wi-Fi Direct setting in the Advanced Settings menu before you can
enable Wi-Fi Direct mode.

1. Press the arrow buttons to select Wi-Fi Setup and press the OK button.
You see this screen:

2. Select Wi-Fi Direct Setup and press the OK button.
3. Select Connection Setup and press the OK button.
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You see this screen:

4. Press the OK button to view the SSID (Wi-Fi network name) and password.
5. Use your computer or wireless device to select the Wi-Fi network name (SSID) displayed on the

LCD screen, and enter the password shown.
6. Press the OK button to exit.

You see either the AP or D connection symbol on the LCD screen and should be able to print directly
to your product from your computer or device.

Note: If the AP or D connection symbol is not displayed on the LCD screen, Wi-Fi Direct mode is not
enabled. Repeat these steps to try again.

Parent topic: Wi-Fi Direct Mode Setup
Related references
Status Icons

Changing the Wi-Fi Direct Password
You can change the Wi-Fi Direct password from the default to improve the security of your Wi-Fi Direct
connections.

Note: If you change the Wi-Fi Direct password, you cannot use the built-in NFC functionality to connect
to the product. If you have already connected devices or computers to your product via Wi-Fi Direct, they
are disconnected when you change the password.

1. Press the arrow buttons to select Wi-Fi Setup and press the OK button.
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You see this screen:

2. Select Wi-Fi Direct Setup and press the OK button.
3. Select Connection Setup and press the OK button.
4. Select Change Password and press the OK button.
5. Press the OK button.

Note: If you have already connected devices or computers to your product via Wi-Fi Direct, they will
be disconnected when you change the password. In addition, the NFC tag will be disabled.

6. Enter a new Wi-Fi Direct password using the control panel buttons.

Note: Your password must be at least 8 and no more than 22 characters long.

• To enter letters or symbols, press the up or down arrow buttons to scroll through characters, and
press the right arrow button to select one.

• To enter numbers or change the case of letters, press the Stop button.
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• To delete the previous character, press the left arrow button.
• To enter a space, press the right arrow button.

7. Press the OK button when you’re finished entering your password.
8. Press the up arrow button.

You see this screen:

9. Press the OK button to view the SSID (Wi-Fi network name) and password.
10. Use your computer or wireless device to select the Wi-Fi network name (SSID) displayed on the

LCD screen, and enter the password shown.
11. Press the Back button to exit.

You see either the AP or D connection symbol on the LCD screen and should be able to print directly
to your product from your computer or device.

Note: If the AP or D connection symbol is not displayed on the LCD screen, Wi-Fi Direct mode is not
enabled. Repeat these steps to try again.

Parent topic: Wi-Fi Direct Mode Setup
Related tasks
Printing with NFC from Your Android Device

Wi-Fi Protected Setup (WPS)
If your network uses a WPS-enabled wireless router or access point, you can quickly connect your
product to the network using Wi-Fi Protected Setup (WPS).

38



Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access
point. If there is no hardware button, there may be a virtual WPS button in the software for the device.
Check your network product documentation for details.

Using WPS to Connect to a Network
Parent topic: Wi-Fi or Wired Networking

Using WPS to Connect to a Network
If you have a WPS-enabled wireless router or access point, you can use Wi-Fi Protected Setup (WPS) to
connect your product to the network.
1. Press the arrow buttons to select Wi-Fi Setup and press the OK button.

You see this screen:

2. Select Push Button Setup (WPS) and press the OK button.
3. Follow the instructions on the LCD screen to complete WPS setup.
4. Press the Back button to exit.

Your product should now be connected to the network.
Parent topic: Wi-Fi Protected Setup (WPS)

Printing a Network Status Sheet
You can print a network status sheet to help you determine the causes of any problems you may have
using your product on a network.
1. Press the arrow buttons to select Menu and press the OK button.
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You see this screen:

2. Select Network Status and press the OK button.
3. Select Wi-Fi/Network Status and press the OK button.

You see a screen like this:

4. Press the OK button to print the network status sheet.
5. Press the up arrow button to begin printing the network status sheet.
Examine the settings shown on the network status sheet to diagnose any problems you have.
Parent topic: Wi-Fi or Wired Networking

Changing or Updating Network Connections
See these sections to change or update how your product connects to a network.
Accessing the Web Config Utility
Changing a USB Connection to a Wi-Fi Connection
Changing a Wi-Fi Connection to a Wired Network Connection
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Connecting to a New Wi-Fi Router
Disabling Wi-Fi Features
Parent topic: Wi-Fi or Wired Networking

Accessing the Web Config Utility
You can select your product's network settings and confirm its operating status using a web browser.
You do this by accessing your product's built-in Web Config utility from a computer or other device that is
connected to the same network as your product.

Note: For more information on the Web Config utility see the Administrator's Guide.

1. Print a network status sheet.
2. Locate the IP Address for your product that is listed on the network status sheet.
3. On a computer or other device connected to the same network as your product, open a web

browser.
4. Enter your product's IP address into the address bar.

You see the available Web Config utility options.
Parent topic: Changing or Updating Network Connections
Related tasks
Printing a Network Status Sheet

Changing a USB Connection to a Wi-Fi Connection
If you have already connected your product to your computer using a USB connection, you can change
to a Wi-Fi connection.
1. Disconnect the USB cable from your product.
2. Uninstall your product software.
3. Download and install your product software from the Epson website using the instructions on the

Start Here sheet.
Parent topic: Changing or Updating Network Connections

Changing a Wi-Fi Connection to a Wired Network Connection
If you have already connected your product to your computer wirelessly, you can change to a wired
network connection if necessary.
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1. Disable your product's Wi-Fi features.
2. Connect one end of an Ethernet network cable to the product's LAN port.
3. Connect the other end to any available LAN port on your router or access point.
4. Uninstall your product software.
5. Download and install your product software from the Epson website.
6. Follow the on-screen instructions to install the software.
7. When you see the Select Your Connection screen, select Wired network connection.
8. If you see a Select Setup Option screen, select Set up printer for the first time.
9. Continue following the rest of the on-screen instructions.
Parent topic: Changing or Updating Network Connections
Related tasks
Disabling Wi-Fi Features

Connecting to a New Wi-Fi Router
If you change the wireless router you have been using on your network, you need to update your
product's Wi-Fi connection to the new router.

Note: If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

1. Do one of the following:
• Windows: Uninstall your product software.
• OS X: Go to the next step.

2. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections
Related tasks
Uninstalling Printing Software - Windows

Disabling Wi-Fi Features
You may need to disable your product's Wi-Fi features if you change your network connection type or
need to solve a problem with your network connection.
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Note: Before disabling Wi-Fi features, make a note of your product's SSID (network name) and
password, and any network settings selected for the Epson Connect services you may use.

1. Press the arrow buttons to select Wi-Fi Setup and press the OK button.
You see this screen:

2. Select Disable Wi-Fi and press the OK button.
3. Press the up arrow button to disable Wi-Fi.
Parent topic: Changing or Updating Network Connections
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Enabling Epson Universal Print Driver (PCL) or PostScript
Printing

Before enabling Epson Universal Print Driver (PCL) or PostScript printing on your product, make sure
you have installed the software as described on the Start Here sheet.
To download the Epson Universal Print Driver or PostScript drivers, go to epson.com/support/wf6090.
Selecting PDL (Page Description Language) Settings
Selecting Printer Language and Interface Settings
Printing a PS3 (PostScript) Status Sheet

Selecting PDL (Page Description Language) Settings
You can select settings for PCL and PostScript printing using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the arrow buttons to select Menu and press the OK button.
You see a screen like this:

2. Select System Administration and press the OK button. Enter the administrator password, if
necessary.

3. Select Universal Print Settings and press the OK button.
4. Select PDL Print Configuration and press the OK button.
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You see a screen like this:

5. Select an option, then select the settings you want to use.
PDL Print Configuration Options
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

PDL Print Configuration Options
Select the PDL Print Configuration settings you want to use for PCL or PostScript printing.

Setting Available Description
options

Common Settings
Paper Size Various sizes Sets the default paper size for PCL or PostScript

printing.
Paper Type Various paper Sets the default paper type for PCL or PostScript

types printing.
Orientation Portrait Sets the default orientation for PCL or PostScript

printing.Landscape
Quality Draft Sets the quality for PCL or PostScript printing.

Standard
Best

Ink Save Mode On/Off Saves ink by reducing print density.
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Setting Available Description
options

Print Order Last Page on Starts printing from the first page of a file.
Top
First Page on Starts printing from the last page of a file.
Top

Number of Copies 1 to 999 Selects the number of copies to print.
Binding Margin Left Edge Specifies the binding edge for double-sided documents.

Top Edge
Auto Paper Ejection On/Off Ejects paper automatically when printing is stopped

during a print job.
2-Sided Printing On/Off Selects duplex printing.
PCL Menu
Font Source Resident Uses a font preinstalled on the printer.

Download Uses a font you have downloaded.
Font Number 1 to 111 Selects the default font number for the default font

source.
Pitch 0.44 to 99.99 cpi Selects the default font pitch if the font is scalable and

fixed-pitch (availability depends on font source and
number settings).

Height 4.00 to 999.75 pt Selects the default font height if the font is scalable and
proportional (availability depends on font source and
number settings).

Symbol Set Various Selects the default symbol set. If the selected font is not
available for the selected symbol set, the font source
and number are replaced with IBM-US (the default
setting).

Form 5 to 128 lines Sets the number of lines for the selected paper size and
orientation. Changes the line spacing (VMI) stored in
the printer. Later changes in page size or orientation
cause changes in the Form value based on the stored
VMI.
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Setting Available Description
options

CR Function CR Selects the line feed command when printing with a
driver from a specific operating system.CR+LF

LF Function LF
CR+LF

Paper Source Assign 4 Makes the paper source select command compatible
with HP LaserJet 4

4K Makes the paper source select command compatible
with HP LaserJet 4000, 5000, and 8000

5S Makes the paper source select command compatible
with HP LaserJet 5S

PS3 Menu
Error Sheet On/Off Prints a sheet showing the status when errors occur

during PostScript or PDF printing.
Coloration Color Selects the color mode for PostScript printing.

Mono
Binary On/Off Enable when printing files that contain binary images

(available when the product is connected to the
network). Allows you to print binary images even if the
driver is set to ASCII.

PDF Page Size Various sizes Selects the paper size when printing a PDF file. If Auto
is selected, the paper size is determined based on the
size of the first page.

Parent topic: Selecting PDL (Page Description Language) Settings

Selecting Printer Language and Interface Settings
You can select printer language and interface settings using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.
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1. Press the arrow buttons to select Menu and press the OK button.
You see a screen like this:

2. Select System Administration and press the OK button. Enter the administrator password, if
necessary.

3. Select Printer Settings.
You see a screen like this:

4. Select the Printing Language and other settings you want to use.
Printer Language and Interface Options
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Printer Language and Interface Options
Select the settings you want to use.
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Settings Available Description
options

USB I/F Timeout Setting 0.5 to 300 Specify the length of time before ending USB
seconds communication from a computer using the PCL or

PostScript driver. This setting is necessary to avoid
endless USB communication.

Printing Language Auto Select the language for the USB or network interface.
PCL
PS3
PDF

PC Connection via USB Enable Select whether to allow USB communication with the
product.Disable

Parent topic: Selecting Printer Language and Interface Settings

Printing a PS3 (PostScript) Status Sheet
You can print a PS3 (PostScript) status sheet to confirm the current font information and PostScript
printing software version.
1. Press the arrow buttons to select Menu and press the OK.

You see this screen:

2. Select Print Status Sheet and press the OK button.
3. Select PS3 Status Sheet and press the OK button.
4. Press the up arrow button to begin printing the network status sheet.
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Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing
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Loading Paper
Before you print, load paper for the type of printing you will do.

Note: Load only plain paper when printing with the PCL or PostScript (PS3) printer software.

Loading Paper in the Cassette
Loading Paper and Envelopes in the Rear Paper Feed Slot
Loading Paper in the Front Paper Feed Slot
Paper Loading Capacity
Available Epson Papers
Paper or Media Type Settings - Printing Software
Selecting the Paper Settings for Each Source - Control Panel
Selecting the Paper Source Settings - Administrator
Selecting Default Paper Settings - Administrator
Installing the Optional Paper Cassette Units

Loading Paper in the Cassette
You can load paper up to this size in the paper cassette: Legal (8.5 × 14 inches [216 × 356 mm]).
1. Make sure the product is not operating and pull out the paper cassette.
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2. Pinch and slide the front edge guide outward all the way, then pinch and slide the side edge guides
to the marker for the paper size you are using.

1 Paper size marker
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3. Load paper with the printable side facedown and slide the front edge guide to the marker for the
paper size you are using.

Note: Make sure the paper fits beneath the arrow mark inside the edge guides.

1 Paper size marker

4. Make sure the paper size label matches the size of the paper loaded in the paper cassette. If
necessary, remove the label holder, change the paper size indicated on the label, and replace the
label holder.

5. Insert the paper cassette all the way into the product.
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6. Extend the output tray and flip open the paper stopper.

7. Select the size and type of paper you loaded on the product LCD screen.
Always follow these paper loading guidelines:
• Load only the recommended number of sheets.
• Load paper short edge first, no matter which way your document faces.
• Load the printable side facedown.
• Load letterhead or pre-printed paper top edge first.
• Do not load paper above the arrow mark inside the edge guides.
• Check the paper package for any additional loading instructions.
Parent topic: Loading Paper
Related references
Paper Loading Capacity
Related tasks
Loading Paper and Envelopes in the Rear Paper Feed Slot
Loading Paper in the Front Paper Feed Slot

Loading Paper and Envelopes in the Rear Paper Feed Slot
You can print on envelopes or paper in a variety of types and sizes in the rear paper feed slot.
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1. Flip the feeder guard forward and pull up the paper support and extension.

2. Slide the edge guides outward.
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3. If you are inserting a stack of paper, fan the sheets and tap the stack on a flat surface to even the
edges.

Note: You can load one sheet of binder paper with holes on one of the long edges as shown. Do not
select automatic 2-sided printing for this type of paper.

4. Do one of the following:
• Insert paper, glossy or printable side up and short edge first, in the center of the slot.

Caution: To prevent paper feeding problems, make sure you do not load paper above the arrow
marks inside the edge guides.
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• Load envelopes short edge first, with the flap facing down and the flap edge to the left, in the
center of the slot.

5. Slide the edge guides against the paper or envelope, but not too tightly.

6. Extend the output tray and flip open the paper stopper.

7. Select the size and type of paper you loaded on the product LCD screen.

57



Always follow these paper loading guidelines:
• Load only the recommended number of sheets.
• Load paper short edge first, no matter which way your document faces.
• Load the printable side faceup.
• Load letterhead or pre-printed paper top edge first.
• Do not load paper above the arrow mark inside the edge guides.
• If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one

envelope at a time.
• If print quality declines when printing multiple envelopes, try loading one envelope at a time.
• Do not load envelopes that are curled, folded, or too thin.
• Check the paper package for any additional loading instructions.
Parent topic: Loading Paper
Related references
Paper Loading Capacity
Related tasks
Loading Paper in the Cassette
Loading Paper in the Front Paper Feed Slot

Loading Paper in the Front Paper Feed Slot
You can load one sheet of paper in the front paper feed slot.

Note: You cannot load paper while printing from the front paper feed slot. Paper that is too stiff may not
load correctly even if it meets the paper thickness specifications.
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1. Extend the output tray and flip open the paper stopper.

2. Slide the edge guides to the paper size you are using.

3. Insert the paper with the printable side facedown until the product pulls it in partially.
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Note: Keep the paper straight to prevent it from loading at an angle.

4. Select the size and type of paper you loaded on the product LCD screen.
Always follow these paper loading guidelines:
• Load only one sheet at a time.
• Load paper short edge first, no matter which way your document faces.
• Load the printable side facedown.
• Load letterhead or pre-printed paper top edge first.
• Check the paper package for any additional loading instructions.
Parent topic: Loading Paper
Related references
Paper Loading Capacity
Paper Specifications
Related tasks
Loading Paper in the Cassette
Loading Paper and Envelopes in the Rear Paper Feed Slot

Paper Loading Capacity
Paper cassette and rear paper feed slot

Paper type Loading capacity
Size Paper cassette Rear paper feed

slot
Plain paper1 Letter (8.5 × 11 inches Up to the arrow 80 sheets

[216 × 279 mm]) mark
A4 (8.3 × 11.7 inches
[210 × 297 mm])
Legal (8.5 × 14 inches
[216 × 356 mm])
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Paper type Loading capacity
Size Paper cassette Rear paper feed

slot
Plain paper User defined from — 1 sheet

2.17 × 5 inches (55 × 127 mm)
to 4.13 × 5.83 inches (105 ×
148 mm)
User defined from 4.13 × — 80 sheets
5.83 inches (105 × 148 mm) to
8.5 × 14 inches (215.9 ×
355.6 mm)2

User defined from 8.5 × — 1 sheet
14 inches (215.9 × 355.6 mm) to
8.5 × 47.2 inches (215.9 ×
1200 mm)

Epson Bright White Paper1 Letter (8.5 × 11 inches 400 sheets 50 sheets
[216 × 279 mm])
A4 (8.3 × 11.7 inches
[210 × 297 mm])

Epson Presentation Paper Letter (8.5 × 11 inches — 20 sheets
Matte [216 × 279 mm]) size and

smallerEpson Premium
Presentation Paper Matte
Epson Premium
Presentation Paper Matte
Double-sided
Epson Photo Paper
Glossy
Epson Premium Photo
Paper Glossy
Epson Premium Photo
Paper Semi-gloss
Epson Ultra Premium
Photo Paper Glossy
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Paper type Loading capacity
Size Paper cassette Rear paper feed

slot
Thick paper (cardstock up Letter (8.5 × 11 inches — 10 sheets3

to 68 lb [256 g/m2]) [216 × 279 mm])
A4 (8.3 × 11.7 inches
[210 × 297 mm])

Envelopes No. 10 (4.1 × 9.5 inches — 10 envelopes
[105 × 241 mm])

1 You can print 2-sided print jobs automatically or manually using the paper cassette. When you use the
rear paper feed slot, you can only print 2-sided print jobs manually. Load up to 30 sheets for manual 2-
sided print jobs.
2 You can print 2-sided print jobs manually only in the rear paper feed slot. Load up to 30 sheets for
manual 2-sided print jobs.
3 You can load up to 5 sheets for manual 2-sided print jobs.
Front paper feed slot

Paper type Loading capacity
Size Front paper feed slot

Plain paper Letter (8.5 × 11 inches [216 × 279 mm]) 1 sheet
A4 (8.3 × 11.7 inches [210 × 297 mm])
Legal (8.5 × 14 inches [216 × 356 mm])
User defined from 4.13 × 5.83 inches (105
× 148 mm) to 8.5 × 14 (215.9 × 355.6 mm)
inches

Epson Bright White Paper Letter (8.5 × 11 inches [216 × 279 mm]) 1 sheet
A4 (8.3 × 11.7 inches [210 × 297 mm])

Parent topic: Loading Paper
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Available Epson Papers
You can purchase genuine Epson ink and paper at epson.com/ink3 (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call
800-GO-EPSON (800-463-7766).

Paper Type Size Part number Sheet count
Epson Bright White Paper Letter (8.5 × 11 inches S041586 500

[216 × 279 mm])
Epson Presentation Paper Matte Letter (8.5 × 11 inches S041062 100

[216 × 279 mm])
Legal (8.5 × 14 inches S041067 100
[216 × 356 mm])

Epson Premium Presentation 8 × 10 inches (203 × 254 mm) S041467 50
Paper Matte Letter (8.5 × 11 inches S041257 50

[216 × 279 mm]) S042180 100
Epson Premium Presentation Letter (8.5 × 11 inches S041568 50
Paper Matte Double-sided [216 × 279 mm])
Epson Photo Paper Glossy 4 × 6 inches (102 × 152 mm) S041809 50

S042038 100
Letter (8.5 × 11 inches S041141 20
[216 × 279 mm]) S041649 50

S041271 100
Epson Premium Photo Paper 4 × 6 inches (102 × 152 mm) S041808 40
Glossy S041727 100

16:9 wide (4 × 7.1 inches S042109 20
[102 × 181 mm])
5 × 7 inches (127 × 178 mm) S041464 20
8 × 10 inches (203 × 254 mm) S041465 20
Letter (8.5 × 11 inches S042183 25
[216 × 279 mm]) S041667 50
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Paper Type Size Part number Sheet count
Epson Ultra Premium Photo Paper 4 × 6 inches (102 × 152 mm) S042181 60
Glossy S042174 100

5 × 7 inches (127 × 178 mm) S041945 20
8 × 10 inches (203 × 254 mm) S041946 20
Letter (8.5 × 11 inches S042182 25
[216 × 279 mm]) S042175 50

Epson Premium Photo Paper 4 × 6 inches (102 × 152 mm) S041982 40
Semi-gloss Letter (8.5 × 11 inches S041331 20

[216 × 279 mm])

Parent topic: Loading Paper

Paper or Media Type Settings - Printing Software
For this paper Select this paper Type or Media Type setting
Plain paper Plain Paper / Bright White Paper
Epson Bright White Paper
Letterhead paper Letterhead
Recycled paper Recycled
Color paper Color
Preprinted paper Preprinted
Envelopes Envelope
Epson Ultra Premium Photo Paper Glossy Ultra Premium Photo Paper Glossy
Epson Premium Photo Paper Glossy Premium Photo Paper Glossy
Epson Photo Paper Glossy Photo Paper Glossy
Epson Premium Photo Paper Semi-gloss Premium Photo Paper Semi-Gloss
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For this paper Select this paper Type or Media Type setting
Epson Presentation Paper Matte Premium Presentation Paper Matte
Epson Premium Presentation Paper Matte
Epson Premium Presentation Paper Matte Double-
sided
Thick paper (cardstock up to 68 lb [256 g/m2]) Card Stock

Parent topic: Loading Paper

Selecting the Paper Settings for Each Source - Control Panel
You can change the default paper size and paper type for each paper source using the control panel on
the product.
1. Press the Paper Setup button.
2. Select the paper source you want to change and press the OK button.

You see a screen like this:

3. Select the paper size you loaded and press the OK button.
4. Select the paper type you loaded and press the OK button.
5. Select another paper source to change or press the Back button to exit.
Paper Type Settings - Control Panel
Parent topic: Loading Paper
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Paper Type Settings - Control Panel
Select a Paper Type setting that matches the paper you loaded.

For this paper Select this
Plain paper Plain Paper
Epson Bright White Paper
Letterhead paper Letterhead
Recycled paper Recycled
Color paper Color
Preprinted paper Preprinted
Envelopes Envelope
Epson Ultra Premium Photo Paper Glossy Ultra Glossy
Epson Premium Photo Paper Glossy Prem. Glossy
Epson Photo Paper Glossy Glossy
Epson Premium Photo Paper Semi-gloss Prem. Semi-Gloss
Epson Presentation Paper Matte Prem. Matte
Epson Premium Presentation Paper Matte
Epson Premium Presentation Paper Matte Double-
sided
Cardstock up to 68 lb (256 g/m2) Card Stock

Parent topic: Selecting the Paper Settings for Each Source - Control Panel

Selecting the Paper Source Settings - Administrator
You can change default paper source settings using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the arrow buttons to select Menu and press the OK button.
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2. Select System Administration and press the OK button. Enter the administrator password, if
necessary.
You see this screen:

3. Select Printer Settings and press the OK button.
4. Select Paper Source Settings and press the OK button.

You see a screen like this:

5. Select the paper source options you want to use.
6. When you are finished, press the Back button to exit.
Paper Source Settings Options
Parent topic: Loading Paper

Paper Source Settings Options
Select the Paper Source Settings options you want to use for your printed jobs.
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Paper Source Available settings Description
Settings option
Rear Paper Feed Normal Select Normal to give printing priority to paper loaded in the
Priority rear paper feed slotLast
A4/Letter Auto On Select On to switch the selected paper size to match the
Switching loaded paper (Letter or A4) if the wrong size is selectedOff
Auto Select Available paper Select On to include a paper source when the product
Settings sources automatically searches for a paper source to match a print

job
Error Notice Paper Size Notice Select On for either of these settings to display an error

message when the selected paper type or size does notPaper Type Notice match the loaded paper

Parent topic: Selecting the Paper Source Settings - Administrator

Selecting Default Paper Settings - Administrator
As an administrator, you can adjust default paper settings that apply to all print jobs sent to the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

Selecting the Default Printer Settings - Control Panel
Selecting Universal Print Settings
Parent topic: Loading Paper

Selecting the Default Printer Settings - Control Panel
You can change default printer settings using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the Back button, if necessary.
2. Select Menu.

68



You see a screen like this:

3. Scroll down and select System Administration. Enter the administrator password, if necessary.
You see a screen like this:

4. Select Printer Settings.
5. Select the Paper Source Settings options you want to use.
6. Select one of these Auto Error Solver options:

• Turn on this setting to display a warning and print single-sided when a 2-sided printing error
occurs, or to print only what the product could process when a memory full error occurs.

• Turn off this setting to display an error message and stop printing if an error occurs.
7. When you are finished, press the Back button to exit.
Parent topic: Selecting Default Paper Settings - Administrator

Selecting Universal Print Settings
You can change the default universal print settings using the product control panel.
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Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the arrow buttons to select Menu and press the OK button.
2. Select System Administration and press the OK button. Enter the administrator password, if

necessary.
You see this screen:

3. Select Universal Print Settings and press the OK button.
You see this screen:

4. Adjust the settings as necessary.
5. When you are finished, press the Back button to exit.
Universal Print Settings Options
Parent topic: Selecting Default Paper Settings - Administrator
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Universal Print Settings Options
Select the universal print settings you want to use.

Universal Print Available Description
Settings option settings
Top Offset — Adjust the top or left margin.
Left Offset
Top Offset in Back — Adjust the top or left margin of the back page when performing

double-sided printing.Left Offset in Back
Check Paper Width On Select On to check the paper width before printing. This

prevents printing beyond the edges of the paper when theOff paper size settings are wrong, but may reduce the printing
speed.

Dry Time Standard Select the drying time when printing double-sided.
Long
Longer

Skip Blank Page On Select On to skip blank pages automatically.
Off

PDL Print Common Selects the settings for printing with PCL and PostScript Page
Configuration Settings Description Language drivers.

PCL Menu
PS3 Menu

Parent topic: Selecting Universal Print Settings

Installing the Optional Paper Cassette Units
You can install up to two optional paper cassette units to provide more paper capacity.
1. Turn off the product, unplug the power cord, and disconnect any connected cables.

Warning: To avoid electric shock, make sure you unplug the power cord.
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2. Uninstall any optional cassette units already installed on the product.

Note: To uninstall any optional cassette units, turn off the product, unplug the power cord,
disconnect any cables, and follow the rest of these instructions in reverse.

3. Remove the paper cassette unit from its packaging and remove any protective materials.
4. Make sure you have all the items shown here:

5. Remove the output tray and paper cassette from the product.
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6. Remove the paper cassette from the optional paper cassette unit.
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7. Stack all optional paper cassette units on top of each other and secure them to each other with the
included screws.
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8. Lift up your product and gently lower it onto the paper cassette unit with the corners aligned. Secure
the product to the paper cassette unit with the included screws using a screwdriver.
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Warning: To lift the product, have two people hold it as shown here. Lifting from other areas may
cause the product to fall or cause you to pinch your fingers when placing the product down.

9. Secure the back of the paper cassette units to each other and to the product using the included
brackets and screws.

10. Insert a label into the holder indicating the paper size to be loaded in each paper cassette.
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11. Place the correct sticker on each cassette unit to indicate the cassette number.
12. Connect the power cord and other interface cables, then plug in the product.
13. Turn on the product.
14. Pull out and reinsert the paper cassette in each optional paper cassette unit to confirm the cassette

unit is displayed on the Paper Setup screen.
15. Enable the optional paper cassette units in the printer software.
Enabling the Optional Paper Cassettes - Windows
Enabling the Optional Paper Cassettes - OS X
Parent topic: Loading Paper
Related tasks
Synchronizing Printer Settings - Epson Universal Print Driver - Windows
Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows
Enabling the Optional Paper Cassettes - PostScript Printer Software - OS X

Enabling the Optional Paper Cassettes - Windows
You need to enable the optional paper cassette units before you can use them with the printer software.

Note: If you are using the Epson Universal Print Driver or PostScript (PS3) printer software, see the
sections covering that software in this manual to enable the optional cassette units.

1. Do one of the following:

• Windows 10: Right-click and select Control Panel > Hardware and Sound > Devices and
Printers. Right-click your product name and select Printer properties.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name and select Printer properties.

• Windows 7: Click and select Devices and Printers. Right-click your printer name and select
Printer properties.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
then right-click your printer name and select Properties.

• Windows XP: Click Start and select Printers and Faxes. Right-click your product name and
select Properties.

2. Click the Optional Settings tab.
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You see a window like this:

3. Make sure Acquire from Printer is selected, then click Get.
The optional paper sources are listed in the Current Printer Information section.

4. Click OK.
The optional paper cassettes are now enabled.
Parent topic: Installing the Optional Paper Cassette Units
Related tasks
Synchronizing Printer Settings - Epson Universal Print Driver - Windows
Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows

Enabling the Optional Paper Cassettes - OS X
You need to enable the optional paper cassette units before you can use them with the printer software.
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Note: If you are using the PostScript (PS3) printer software, see the section covering that software to
enable the optional cassette units.

1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options

& Supplies.
3. Select Driver or Options.

You see a screen like this:

4. Select the number of optional cassette units installed for the Lower Cassette setting.
5. Click OK.
The optional paper cassettes are now enabled.
Parent topic: Installing the Optional Paper Cassette Units
Related tasks
Enabling the Optional Paper Cassettes - PostScript Printer Software - OS X
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Printing from a Computer
Before printing from your computer, make sure you have set up your product and installed its software
as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website. If you see a Software Update screen, select Enable automatic checking
and click OK. The update scans your system to see if you have the latest product software. Follow the
on-screen instructions.

Printing with Windows
Printing with OS X
Printing with the Epson Universal Print Driver - Windows
Printing with the PostScript (PS3) Printer Software - Windows
Printing with the PostScript (PS3) Printer Software - OS X
Cancelling Printing Using a Product Button

Printing with Windows
You can print with your product using any Windows application, as described in these sections.
Selecting Basic Print Settings - Windows
Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting a Printing Preset - Windows
Selecting Extended Settings - Windows
Printing Your Document or Photo - Windows
Locking Printer Settings - Windows
Selecting Default Print Settings - Windows
Changing Automatic Update Options
Parent topic: Printing from a Computer

Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
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2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:

4. For the Paper Source setting, select where you loaded the paper you want to print on.
5. Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.

81



6. Select the orientation of your document.

Note: If you are printing an envelope, select Landscape.

7. Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

8. Select the Quality setting that matches the print quality you want to use.
9. Select a Color option:

• To print a color document or photo, select the Color setting.
• To print text and graphics in black or shades of gray, select the Black/Grayscale setting.

10. To print on both sides of the paper, select the 2-Sided Printing setting and select the options you
want.

11. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select
one of the settings in the Multi-Page menu and select the printing options you want.

12. To print multiple copies and arrange their print order, select the Copies options.
13. To preview your job before printing, select Print Preview.
14. To save your print job as a project that can be modified and combined with other print jobs, select

Job Arranger Lite.
15. To reduce noise during printing when you select Plain Paper/Bright White Paper, select On in the

Quiet Mode menu.
Paper Source Options - Windows
Print Quality Options - Windows
Multi-Page Printing Options - Windows
Parent topic: Printing with Windows
Related references
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Double-sided Printing Settings - Windows
Printing Your Document or Photo - Windows
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Paper Source Options - Windows
You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.

Note: Paper Cassette 2 and Paper Cassette 3 are available only if you have installed the optional
cassettes.

Auto Select
Automatically selects the paper source based on the selected paper size.

Paper Cassette 1
Selects the paper in cassette 1 as the paper source.

Paper Cassette 2
Selects the paper in cassette 2 as the paper source.

Paper Cassette 3
Selects the paper in cassette 3 as the paper source.

Rear Paper Feed
Selects the paper in the rear feed slot as the paper source.

Front Paper Feed Slot
Selects the paper in the front feed slot as the paper source.

Parent topic: Selecting Basic Print Settings - Windows
Print Quality Options - Windows

You can select any of the available Quality options to fine-tune the quality of your print. Some settings
may be unavailable, depending on the paper type and border setting you have chosen.
Draft

For draft printing on plain paper.
Standard

For everyday text and image printing.
Standard - Vivid

For text and graphics with good quality and print speed.
High

For photos and graphics with high print quality.
More Settings

Opens a window that lets you choose among levels of speed and quality.
Parent topic: Selecting Basic Print Settings - Windows

83



Multi-Page Printing Options - Windows
You can select any of the available options in the Multi-Page menu to set up your multi-page print job.
2-Up and 4-Up

Prints 2 or 4 pages on one sheet of paper. Click the Page Order button to select page layout and
border options.

2×1 Poster, 2×2 Poster, 3×3 Poster, 4×4 Poster
Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to
select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main
tab.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network.

1. Select one of the following options for 2-Sided Printing:
• Auto (Long-edge binding) to print your double-sided print job by automatically flipping the paper

on the long edge.
• Auto (Short-edge binding) to print your double-sided print job by automatically flipping the paper

on the short edge.
2. Click the Settings button.
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You see this window:

3. Select the double-sided printing options you want to use.
4. Click OK to return to the Main tab.
5. Click the Print Density button.
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You see this window:

6. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

7. If necessary, select the Adjustments options you want to use.
8. Click OK to return to the Main tab.
9. Print a test copy of your double-sided document to test the selected settings.
10. Follow any instructions displayed on the screen during printing.
Double-sided Printing Options - Windows
Print Density Adjustments - Windows
Parent topic: Printing with Windows
Related tasks
Selecting Basic Print Settings - Windows

Double-sided Printing Options - Windows
You can select any of the available options on the 2-Sided Printing Settings window to set up your
double-sided print job.
Binding Edge Options

Select a setting that orients double-sided print binding in the desired direction.
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Binding Margin Options
Select options that define a wider margin to allow for binding.

Start Page
Selects whether printing starts on the front or back page.

Create Folded Booklet Options
Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows
Print Density Adjustments - Windows

You can select any of the available options on the Print Density Adjustment window to adjust the print
quality of your double-sided print job.
Print Density

Sets the level of ink coverage for double-sided printing.
Increase Ink Drying Time

Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing to prevent ink smearing.

Parent topic: Selecting Double-sided Printing Settings - Windows
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Selecting Additional Layout and Print Options - Windows
You can select a variety of additional layout and printing options for your document or photo on the More
Options tab.

1. To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select one of these sizing options:
• Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of the

your document or photo as the Document Size setting, and the size of your paper as the Output
Paper setting. If you want to center your image on the paper, select the Center option.

• Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.
Select the percentage in the % menu.

2. Select one of the following Color Correction options:
• Select Automatic to automatically adjust the sharpness, brightness, contrast, and color saturation

for your image.
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• Select Custom and click the Advanced button to manually adjust the color correction settings or
turn off color management in your printer software.

• Select Image Options to access additional settings for improving printed images.

Note: You can also select Color Universal Print settings.

3. To add the following features, click the Watermark Features button:
• Anti-Copy Pattern: adds a watermark that only appears when your printout is copied.

Note: This setting is not available for all types of printing.

• Watermark: adds a visible watermark to your printout.

Note: Click the Add/Delete button to create your own watermark, and click the Settings button to
customize the watermark.

• Header/Footer: adds information such as the date and time to the top or bottom of your printout.

Note: Click the Settings button to customize the text and location of the header or footer.

4. To add a password to your print job, select the Confidential Job checkbox, then enter a password.
Confidential jobs are stored in the product's memory without being printed. To print the job, enter the
password for the confidential job on the product's control panel.

Note: Confidential print jobs are cleared from the product's memory after printing.

5. Select any of the Additional Settings options to customize your print.
Custom Color Correction Options - Windows
Image Options and Additional Settings - Windows
Header/Footer Settings - Windows
Parent topic: Printing with Windows
Related tasks
Printing Your Document or Photo - Windows
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Custom Color Correction Options - Windows
You can select any of the available options in the Color Correction window to customize the image colors
for your print job.

Color Controls
Lets you select a Color Mode setting, individual settings for Brightness, Contrast, Saturation, and
Density, and individual color tones. Depending on the selected color mode, you can also adjust the
midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.
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ICM
Lets you manage color using installed color printing profiles.

No Color Adjustment
Turns off color management in your printer software so you can manage color using only your
application software.

Parent topic: Selecting Additional Layout and Print Options - Windows
Image Options and Additional Settings - Windows

You can select any of the Image Options and Additional Settings to customize your print. Some options
may be pre-selected or unavailable, depending on other settings you have chosen.

Image Options
Emphasize Text

Adjusts the weight of printed text to increase readability.
Emphasize Thin Lines

Adjusts the weight of printed lines to increase visibility.
Edge Smoothing

Smooths jagged edges in low-resolution images such as screen captures or images from the Web.
Fix Red-Eye

Reduces or removes red-eye in photos.
Print Text in Black

Prints colored text in black.
For Color Text

Prints colored text on a background pattern or underlined.
For Color Graphs and Images

Prints colored graphics and images with overlay patterns.
For Color Text, Graphs, and Images

Prints colored text, graphics, and images with overlay patterns.
Enhancement Options

Specifies Color Universal Print enhancement settings for text, graphics, and images.

Additional Settings Options
Rotate 180º

Prints the image rotated 180º from its original orientation.
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High Speed
Speeds up printing but may reduce print quality.

Mirror Image
Flips the printed image left to right.

Parent topic: Selecting Additional Layout and Print Options - Windows
Header/Footer Settings - Windows

You can select any of the Header/Footer Settings options to add headers or footers when you print. The
items are available to print at the top or bottom of your pages, in either the left, right, or center of the
page.

Note: These settings are not saved with your document.

You can select to print the following information:
• User Name
• Computer Name
• Date
• Date/Time
• Collate Number (copy number)

Note: The user name, computer name, date, and time come from the Windows Control Panel on your
computer.

Parent topic: Selecting Additional Layout and Print Options - Windows
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Selecting a Printing Preset - Windows
For quick access to common groups of print settings, you can select a printing preset on the Main or
More Options tab.

Note: You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab.
You see the available Printing Presets on the left:
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2. Place your cursor over one of the Printing Presets to view its list of settings.
3. Click on a preset to change its settings, or use any of the available options on the screen to control

your printing presets.
4. To choose a preset for printing, select it.
5. Click OK.
Parent topic: Printing with Windows

Selecting Extended Settings - Windows
You can select additional settings that apply to all the print jobs you send to your product.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
3. Click the Maintenance tab.

You see the maintenance options:
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4. Click the Extended Settings button.
You see this window:

5. Select any of the extended settings to customize your print.
6. Click OK to close the Extended Settings window.
7. Click OK to close the printer software window.
Extended Settings - Windows
Parent topic: Printing with Windows

Extended Settings - Windows
You can select from these settings on the Extended Settings window.
Enable EPSON Status Monitor 3

Enables product monitoring for ink and paper supplies and other issues.
Check Paper Width Before Printing

Prevents printing beyond the edges of the paper if the paper size setting is incorrect; may reduce print
speed.

Thick Paper and Envelopes
Prevents ink from smearing when you print on envelopes or other thick paper.
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Short Grain Paper
Prevents ink from smearing when you print on envelopes or other thick paper, and the Thick Paper
setting does not help.

Separator Page
Before each document, prints a separator page containing the title, user, date, and time.

Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and
other settings do not help.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Change Standard Resolution
Reduces the resolution of print data to correct printing problems.

Refine screening pattern
Prints graphics with a finer screening pattern.

Allow Applications to Perform ICM Color Matching
Allows applications to perform ICM color matching.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Output 1 page documents facedown in 2-Sided mode
Outputs single-sided pages in a 2-sided print job facedown instead of faceup.

Parent topic: Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows
Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.
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You see your application's Print window, such as this one:

2. Click OK or Print to start printing.
Parent topic: Printing with Windows

Locking Printer Settings - Windows
Administrators can lock some printer settings to prevent unauthorized changes.
1. Do one of the following:

• Windows 10: Right-click and select Control Panel > Hardware and Sound > Devices and
Printers. Right-click your product name and select Printer properties.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product and select Printer properties.
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• Windows 7: Click and select Devices and Printers. Right-click your product and select
Printer properties.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
then right-click your product and select Properties.

• Windows XP: Click Start and select Printers and Faxes. Right-click your product and select
Properties.

2. Click the Optional Settings tab.

Note: You can prevent access to the Optional Settings tab by changing the user or group
permissions in the Security tab.

3. Click Driver Settings.
You see this window:

4. Select the checkbox for the settings you want to lock. To lock all print settings, select All Document
Settings.
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5. Under Advanced Settings, select the setting option you want to use for each locked setting.
6. Click OK.
Locked Setting Options
Parent topic: Printing with Windows

Locked Setting Options
Select the options you want to use for any locked print settings.

Setting Options Description
Anti-Copy Various data items Lets you select the data to use for the pattern or prohibit anti-
Pattern copy patterns

Add/Delete Lets you add or delete a customized anti-copy pattern
Settings Lets you select the arrangement, size, and other settings for

the custom anti-copy pattern
Watermark Various text Lets you select the text for the watermark or prohibit

watermarks watermarks
Add/Delete Lets you add or delete a customized text or image-based

watermarkSettings
Lets you select the size, position, color and other watermark
settings

Header/Footer Off Prohibits headers or footers
On Allows headers and footers
Settings Lets you select the text and position for printing headers and

footers
Color Color Allows color printing

Grayscale Allows printing in black or shades of gray only
2-sided printing Off Allows printing on one side of the paper only

On Allows printing on both sides of the paper
Multi-Page Off Prohibits multi-page settings

2-Up Allows printing of 2 pages on one sheet of paper
4-Up Allows printing of 4 pages on one sheet of paper
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Parent topic: Locking Printer Settings - Windows

Selecting Default Print Settings - Windows
When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.

You see the printer settings window:

3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.
These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.
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Changing the Language of the Printer Software Screens
Parent topic: Printing with Windows

Changing the Language of the Printer Software Screens
You can change the language used on the Windows printer software screens.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.

You see the printer settings window.
3. Click the Maintenance tab.

You see the maintenance options:

4. Select the language you want to use as the Language setting.
5. Click OK to close the printer software window.
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The printer software screens appear in the language you selected the next time you access them.
Parent topic: Selecting Default Print Settings - Windows

Changing Automatic Update Options
Your printer software for Windows automatically checks for updates to the product software. You can
change how often the software checks for updates or disable this feature.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Software Update Settings.

You see this window:

3. Do one of the following:
• To change how often the software checks for updates, select a setting in the Check every menu.
• To disable the automatic update feature, select the Never option.

4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Parent topic: Printing with Windows
Related tasks
Checking for Software Updates
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Printing with OS X
You can print with your product using any OS X printing program, as described in these sections.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website.

Selecting Basic Print Settings - OS X
Selecting Page Setup Settings - OS X
Selecting Print Layout Options - OS X
Selecting Double-sided Printing Settings - OS X
Managing Color - OS X
Selecting Printing Preferences - OS X
Printing Your Document or Photo - OS X
Parent topic: Printing from a Computer

Selecting Basic Print Settings - OS X
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
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You see the expanded printer settings window for your product:

Note: The print window may look different, depending on the version of OS X and the application
you are using.

5. Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.
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6. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

8. Select Print Settings from the pop-up menu.
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You see these settings:

9. Select the Paper Source you wish to print from.
10. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

11. Select the Print Quality setting you want to use.
12. Select any of the available print options.
Paper Source Options - OS X
Print Quality Options - OS X
Print Options - OS X
Parent topic: Printing with OS X
Related references
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Page Setup Settings - OS X
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Paper Source Options - OS X
You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.
Auto Select

Automatically selects the paper source based on the selected paper size.
Cassette 1

Selects the paper in cassette 1 as the paper source.
Cassette 2

Selects the paper in cassette 2 as the paper source.
Cassette 3

Selects the paper in cassette 3 as the paper source.
Front Paper Feed Slot

Selects the paper in the front feed slot as the paper source.
Rear Paper Feed

Selects the paper in the rear feed slot as the paper source.
Parent topic: Selecting Basic Print Settings - OS X
Related tasks
Printing Your Document or Photo - OS X

Print Quality Options - OS X
You can select any of the available Print Quality options to fine-tune the quality of your print. Some
settings may be unavailable, depending on the paper type setting you have chosen.
Draft

For draft printing on plain paper.
Normal

For everyday text and image printing.
Normal - Vivid

For everyday text and image printing with good quality and print speed.
Fine

For text and graphics with good quality and print speed.
Quality

For text and graphics with increased quality and print speed.
Best Quality

For the best print quality, but the slowest print speed.
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Parent topic: Selecting Basic Print Settings - OS X
Related tasks
Printing Your Document or Photo - OS X

Print Options - OS X
You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.
Grayscale

Prints text and graphics in black or shades of gray.
Mirror Image

Lets you flip the printed image horizontally.
Parent topic: Selecting Basic Print Settings - OS X
Related tasks
Printing Your Document or Photo - OS X

Selecting Page Setup Settings - OS X
Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting.
2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, select the icon.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.
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Parent topic: Printing with OS X

Selecting Print Layout Options - OS X
You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

• To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

• To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
• To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing with OS X
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Selecting Double-sided Printing Settings - OS X
You can print on both sides of the paper by selecting Two-sided Printing Settings from the pop-up
menu on the print window.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network. This screen may be different, depending on the
version of OS X you are using.

1. Select one of the Two-sided Printing options.
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2. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

3. If necessary, customize the Adjustments settings as instructed on the screen.
4. Print a test copy of your double-sided document to test the selected settings.
5. Follow any instructions displayed on the screen during printing.
Double-sided Printing Options and Adjustments - OS X
Parent topic: Printing with OS X

Double-sided Printing Options and Adjustments - OS X
You can select any of the available options in the Two-sided Printing Settings or Output Settings
pop-up menu to set up your double-sided print job.
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Two-sided Printing Options
Long-Edge binding

Orients double-sided printed pages to be bound on the long edge of the paper.
Short-Edge binding

Orients double-sided printed pages to be bound on the short edge of the paper.

Adjustments
Print Density

Sets the level of ink coverage for double-sided printing.
Increased Ink Drying Time

Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing.

Parent topic: Selecting Double-sided Printing Settings - OS X

Managing Color - OS X
You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout, or
turn off color management in your printer software.
1. Select Color Matching from the pop-up menu in the print window.

2. Select one of the available options.
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3. Select Color Options from the pop-up menu in the print window.

Note: The available settings on the Color Options menu depend on the option you selected on the
Color Matching menu.

4. Select one of the available options.
Color Matching and Color Options - OS X
Parent topic: Printing with OS X

Color Matching and Color Options - OS X
You can select from these settings on the Color Matching and Color Options menus.

Color Matching Settings
EPSON Color Controls

Lets you manage color using controls in your printer software or turn off color management.
ColorSync

Prints using standard color profiles for your product and paper to help match image colors. You can
customize the conversion method and filter settings on the ColorSync pop-up menu in the print
window.
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Color Options Settings
Manual Settings

Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select
settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color
Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-
eye in photos. Depending on the selected color mode, you can also adjust the midtone density using
the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced
Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your
application software.

Note: An ICC profile is required if color management is turned off.

Parent topic: Managing Color - OS X

Selecting Printing Preferences - OS X
You can select printing preferences that apply to all the print jobs you send to your product.
1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options

& Supplies.
3. Select Driver or Options.
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You see a screen like this:

4. Select any of the available printing preferences.
5. Click OK.
Printing Preferences - OS X
Parent topic: Printing with OS X

Printing Preferences - OS X
You can select from these settings on the Options or Driver tab.
Thick Paper and Envelopes

Prevents ink from smearing when you print on envelopes or other thick paper.
Skip Blank Page

Ensures that your product does not print pages that contain no text or images.
Quiet Mode

Lessens noise during printing but may decrease print speed.
Permit temporary black printing

Allows you to print using black ink when color ink is expended.
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High Speed Printing
Speeds up printing but may reduce print quality.

Warning Notifications
Lets you choose whether or not to receive warning notifications from the printer software for various
operating conditions.

Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you
experience issues when using a shared printing pool.

Lower Cassette
Specifies whether the optional cassette is present.

Parent topic: Selecting Printing Preferences - OS X

Printing Your Document or Photo - OS X
Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.

Checking Print Status - OS X
Parent topic: Printing with OS X

Checking Print Status - OS X
During printing, you can view the progress of your print job, control printing, and check ink status.
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1. Click the printer icon when it appears in the Dock.
You see the print status window:

2. Select the following options as necessary for your version of OS X:

• To cancel printing, click the print job and click or Delete.

• To pause a print job, click the print job and click or Hold. To resume a print job, click the
paused print job and click or Resume.

• To pause printing for all queued print jobs, click Pause or Pause Printer.
• To display other printer information, click Settings or Supply Levels.

Parent topic: Printing Your Document or Photo - OS X

Printing with the Epson Universal Print Driver - Windows
You can print with the Epson Universal Print Driver using any Windows printing program, as described in
these sections.
Installing the Epson Universal Print Driver - Windows
Synchronizing Printer Settings - Epson Universal Print Driver - Windows
Selecting Basic Print Settings - Epson Universal Print Driver - Windows
Selecting Additional Layout and Print Options - Epson Universal Print Driver - Windows
Selecting Maintenance Options - Epson Universal Print Driver - Windows
Selecting Default Print Settings - Epson Universal Print Driver - Windows
Locking Printer Settings - Epson Universal Print Driver - Windows

117



Adding Network Printers - Epson Universal Print Driver - Windows
Parent topic: Printing from a Computer

Installing the Epson Universal Print Driver - Windows
The Epson Universal Print Driver supports multiple printer languages, such as PCL and ESC/P-R, and
can be installed on a Windows computer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software. Depending on your model, not all printer languages may be supported.

1. Download the EPSON Universal Print Driver from epson.com/support/wf6090.
2. Double-click the downloaded package.
3. Follow the on-screen instructions until you see this screen:

4. Select Yes: Network connection and click OK.
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Note: Select the Set Default of Printer Control Language to PCL6 checkbox if you want to set the
default printer language to PCL6. Leave this option deselected to set the printer language to ESC/P-
R. (You can change this setting later as needed.)

After the software finishes searching for products, you see a screen like this:

5. Do one of the following:
• If you are installing one product, make sure Add EPSON Universal Print Driver is selected and

continue with the next step.

119



• If you are installing more than one product, select Add found printers and go to step 9.

Note: You can customize and filter your product search results by clicking Display Settings.

6. Open the Select a port to connect a printer menu and select an existing printer port, if necessary.
Otherwise, skip this option to create a new port automatically.

7. Select the product you want to install from the Found Printers list.

Note: Deselect the Set as default printer checkbox if you do not want the product to be set as your
default printer.

8. Click OK, then skip the remaining steps.
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9. If you are installing more than one product, select the products from the Found Printers list and click
Add to Printer Folder.

The selected products appear in the lower section of the screen.
10. Select the checkbox next to the product you want to make your default printer, if necessary.
11. Click OK.
Parent topic: Printing with the Epson Universal Print Driver - Windows
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Synchronizing Printer Settings - Epson Universal Print Driver - Windows
You may need to synchronize the printer driver with the product if the printer driver does not detect the
correct information or settings from the product.

Note: You must sync the printer driver before you can use any optional equipment installed on the
product, such as an optional cassette unit.

1. Do one of the following:

• Windows 10: Right-click and select Control Panel > Hardware and Sound > Devices and
Printers. Right-click EPSON Universal Print Driver and select Printer properties.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

• Windows 7: Click and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.

• Windows XP: Click Start and select Printers and Faxes. Right-click EPSON Universal Print
Driver and select Properties.

2. Click the Optional Settings tab.
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You see this window:

3. Make sure Acquire from Printer is selected and click Get.

Note: Select the Only Optional Information checkbox if you only want to enable optional
equipment, such as an optional cassette unit.

The product's settings and other information appears in the Current Printer Information area.
4. Click OK.
Parent topic: Printing with the Epson Universal Print Driver - Windows
Related tasks
Enabling the Optional Paper Cassettes - Windows
Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows
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Selecting Basic Print Settings - Epson Universal Print Driver - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select EPSON Universal Print Driver as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:

Note: For more information about a setting, right-click it and select Help.
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4. For the Paper Source setting, select where you loaded the paper you want to print on.
5. Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.

6. Select the orientation of your document.

Note: If you are printing an envelope, select Landscape.

7. Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

8. Select the Quality setting that matches the print quality you want to use.
9. Select a Color option:

• To print a color document or photo, select the Color setting.
• To print text and graphics in black or shades of gray, select the Grayscale setting.

10. To print on both sides of the paper, select one of the 2-Sided Printing settings.
11. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select

one of the settings in the Multi-Page menu and select the printing options you want.
12. To print multiple copies and arrange their print order, select the Copies options.
13. To preview your job before printing, select Print Preview.
14. To save your print job as a project that can be modified and combined with other print jobs, select

Job Arranger Lite.
Parent topic: Printing with the Epson Universal Print Driver - Windows
Related references
Paper Source Options - Windows
Print Quality Options - Windows
Multi-Page Printing Options - Windows
Paper or Media Type Settings - Printing Software
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Selecting Additional Layout and Print Options - Epson Universal Print Driver -
Windows

You can select a variety of additional layout and printing options for your document or photo on the More
Options tab.

Note: For more information about a setting, right-click it and select Help.

1. To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select one of these sizing options:
• Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of the

your document or photo as the Document Size setting, and the size of your paper as the Output
Paper setting. If you want to center your image on the paper, select the Center option.

• Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.
Select the percentage in the % menu.
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2. Select one of the following Color Correction options:
• Select Automatic to automatically adjust the sharpness, brightness, contrast, and color saturation

for your image.
• Select Custom and click the Advanced button to manually adjust the color correction settings or

turn off color management in your printer software.
• Select Image Options to access additional settings for improving printed images.

3. To add the following features, click the Watermark Features button:
• Watermark: adds a visible watermark to your printout.

Note: Click the Add/Delete button to create your own watermark, and click the Settings button to
customize the watermark.

• Header/Footer: adds information such as the date and time to the top or bottom of your printout.

Note: Click the Settings button to customize the text and location of the header or footer.

4. To add a password to your print job, select the Confidential Job checkbox, then enter a password.
Confidential jobs are stored in the product's memory without being printed. To print the job, enter the
password for the confidential job on the product's control panel.

Note: Confidential print jobs are cleared from the product's memory after printing.

5. Select any of the Additional Settings options to customize your print.
Parent topic: Printing with the Epson Universal Print Driver - Windows
Related references
Custom Color Correction Options - Windows
Image Options and Additional Settings - Windows
Header/Footer Settings - Windows
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Selecting Maintenance Options - Epson Universal Print Driver - Windows
You can select maintenance and other optional settings on the Maintenance tab.

Note: For more information about a setting, right-click it and select Help.

• Nozzle Check lets you print a nozzle check pattern to check for clogged nozzles.
• Head Cleaning lets you clean the print head.
• Network printer search lets you search for and connect to a product on the network.
• Job Arranger Lite lets you save your print job as a project that can be modified and combined with

other print jobs.
• Extended Settings lets you change a variety of print settings.
• Print Queue displays all the print jobs in queue. You can also cancel or restart print jobs.
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• Printer and Option Information displays information on the printer settings and any optional
equipment installed.

• Language lets you change the language of the printer software screens.
Extended Settings - Epson Universal Print Driver - Windows
Parent topic: Printing with the Epson Universal Print Driver - Windows
Related concepts
Print Head Nozzle Check
Print Head Cleaning

Extended Settings - Epson Universal Print Driver - Windows
You can select from these settings on the Extended Settings window.

Printer Control Language
Lets you select the printer control language.

Graphics Mode
Lets you select the mode by which to output PDL commands to the product.

TrueType Font
Lets you select how you want to print TrueType fonts.

Offset Settings
Lets you make fine-tune adjustments to the print position of data on your printout.
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Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and
other settings do not help.

Refine screening pattern
Prints graphics with a finer screening pattern.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Uses the collate settings specified in the application
Prints using the collate setting in your application.

Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Collate Using Printer Driver
Prints and collates multi-page documents using the printer driver. Deselect this checkbox to use the
product to collate your print jobs instead. (This setting is automatically enabled if there is not enough
memory on the product to collate your print job.)

Output 1 page documents facedown in 2-Sided mode
Outputs single-sided pages in a 2-sided print job facedown instead of faceup.

Parent topic: Selecting Maintenance Options - Epson Universal Print Driver - Windows

Selecting Default Print Settings - Epson Universal Print Driver - Windows
When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.
1. Do one of the following:

• Windows 10: Right-click and select Control Panel > Hardware and Sound > Devices and
Printers. Right-click EPSON Universal Print Driver and select Print Preferences.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Print Preferences.
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• Windows 7: Click and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printing Preferences.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
right-click EPSON Universal Print Driver, and select Printing Preferences.

• Windows XP: Click Start and select Printers and Faxes. Right-click EPSON Universal Print
Driver and select Printing Preferences.

You see the printer settings window:

Note: For more information about a setting, right-click it and select Help.

2. Select the print settings you want to use as defaults in all your Windows programs.
3. Click OK.
These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.
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Parent topic: Printing with the Epson Universal Print Driver - Windows

Locking Printer Settings - Epson Universal Print Driver - Windows
Administrators can lock some printer settings to prevent unauthorized changes. The following settings
can be locked:
1. Do one of the following:

• Windows 10: Right-click and select Control Panel > Hardware and Sound > Devices and
Printers. Right-click EPSON Universal Print Driver and select Print Preferences.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

• Windows 7: Click and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.

• Windows XP: Click Start and select Printers and Faxes. Right-click EPSON Universal Print
Driver and select Properties.

2. Click the Optional Settings tab.
3. Click Driver Settings.
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You see this window:

4. Select the checkbox for the settings you want to lock. To lock all print settings, select All Document
Settings.

5. Under Advanced Settings, select the setting option you want to use for each locked setting.
6. Click OK.
Epson Universal Print Driver Locked Setting Options
Parent topic: Printing with the Epson Universal Print Driver - Windows

Epson Universal Print Driver Locked Setting Options
Select the options you want to use for any locked print settings.
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Setting Options Description
Watermark Various text Lets you select the text for the watermark or prohibit

watermarks watermarks
Add/Delete Lets you add or delete a customized text or image-based

watermarkSettings
Lets you select the size, position, color and other watermark
settings

Header/Footer Off Prohibits headers or footers
On Allows headers and footers
Settings Lets you select the text and position for printing headers and

footers
Color Color Allows color printing

Grayscale Allows printing in black or shades of gray only
2-sided printing Off Allows printing on only one side of the paper

On Allows printing on both sides of the paper
Multi-Page Off Prohibits multi-page settings

2-Up Allows printing of 2 pages on one sheet of paper
4-Up Allows printing of 4 pages on one sheet of paper

Parent topic: Locking Printer Settings - Epson Universal Print Driver - Windows

Adding Network Printers - Epson Universal Print Driver - Windows
You can use the Epson Universal Print Driver to find and add network printers.
1. Do one of the following:

• Windows 10: Right-click and select Control Panel > Hardware and Sound > Devices and
Printers. Right-click EPSON Universal Print Driver and select Printer properties.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.
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• Windows 7: Click and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.

• Windows XP: Click Start and select Printers and Faxes. Right-click EPSON Universal Print
Driver and select Properties.

2. Click the Optional Settings tab.
You see this window:

3. Click Network printer search.
4. When you see the search results, select Add found printers.
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You see a screen like this:

5. Select the printer or printers you want to add.
6. Click Add to Printer Folder.

The selected printer or printers appear in the lower section of the screen.
7. Select the checkbox next to the product you want to make your default printer, if necessary.
8. Click OK.
Parent topic: Printing with the Epson Universal Print Driver - Windows
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Printing with the PostScript (PS3) Printer Software - Windows
You can print with the PostScript (PS3) printer software using any Windows printing program, as
described in these sections.

Note: The PostScript printer software supports products that are connected via Ethernet. If your product
is connected via USB, you will need to install the standard Epson printer software. To download the
standard Epson printer software, go to epson.com/support/wf6090.

Installing the PostScript (PS3) Printer Software - Windows
Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows
Selecting Basic Print Settings - PostScript Printer Software - Windows
Selecting Additional Layout and Print Options - PostScript Printer Software - Windows
Selecting Default Print Settings - PostScript Printer Software - Windows
Parent topic: Printing from a Computer

Installing the PostScript (PS3) Printer Software - Windows
If you did not install the standard Epson printer software, you need to install the PostScript (PS3) printer
software before you can adjust the print settings and print to your network printer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software.

1. Download the PS3/Postscript software package from epson.com/support/wf6090.
2. Double-click the downloaded package.
3. Click OK.
4. Click Accept.
5. Click Install.
6. Click Next and follow the on-screen instructions.
Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows
If you installed optional paper cassette units, you need to enable the optional cassette units before you
can use them with the PS3 printer software.
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1. Do one of the following:

• Windows 10: Right-click and select Control Panel > Hardware and Sound > Devices and
Printers. Right-click your product name and select Printer properties.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name and select Printer properties.

• Windows 7: Click and select Devices and Printers. Right-click your product name and select
Printer Properties.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
then right-click your product name, and select Properties.

• Windows XP: Click Start and select Printers and Faxes. Right-click your product name and
select Properties.

2. Click the Device Settings tab.
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You see a window like this:

3. Select the number of optional cassettes installed as the Lower Cassette Unit setting.
4. Click OK.
The optional paper cassettes are now enabled.
Parent topic: Printing with the PostScript (PS3) Printer Software - Windows
Related tasks
Enabling the Optional Paper Cassettes - Windows
Synchronizing Printer Settings - Epson Universal Print Driver - Windows
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Selecting Basic Print Settings - PostScript Printer Software - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use, and then click the
Preferences button.
You see the Layout tab of your printer settings window:

4. Select the orientation of your document.
5. To print on both sides of the paper, select one of the Print on Both Sides settings.
6. To change the printing order of the pages, select one of the Page Order settings.
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7. To print multiple pages on one sheet of paper, adjust the Pages per Sheet setting.
8. To create a folded booklet out of your photo or document, select the Booklet option.
9. Click the Paper/Quality tab.

You see this window:

10. Select the Paper Source that matches where you loaded the paper you want to print on.
11. Select Plain as the Media setting.

Note: The PostScript printer software supports plain paper printing on these paper and envelope
sizes:
• A4 (8.3 × 11.7 inches [210 × 297 mm])
• Letter (8.5 × 11 inches [216 × 279 mm])
• No. 10 (4.1 × 9.5 inches [105 × 241 mm])
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12. Select one of the following as the Color setting:
• To print a color document or photo, select the Color setting.
• To print text and graphics in black only, select the Black & White setting.

Parent topic: Printing with the PostScript (PS3) Printer Software - Windows
Related tasks
Selecting Additional Layout and Print Options - PostScript Printer Software - Windows
Selecting Default Print Settings - PostScript Printer Software - Windows

Selecting Additional Layout and Print Options - PostScript Printer Software - Windows
You can select a variety of additional layout and printing options for your document or photo by clicking
the Advanced button.

1. Select the size of the paper you loaded as the Paper Size setting.
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2. Select the Print Quality option that matches the print quality you want to use.
3. Adjust the Scaling setting to reduce or enlarge your document or photo by a specific percentage.
4. To utilize the Windows Image Color Management system, set the ICM Method option to one of the

ICM Handling options and select the ICM Intent setting you want to use.
5. Adjust the Pages Per Sheet Layout setting to change the order of multiple pages on a single sheet

of paper when you have adjusted the Pages Per Sheet setting on the Layout tab.
6. Adjust the Booklet Binding Edge setting to change the orientation of your printed booklet.
7. Expand the PostScript Options heading to access the advanced PostScript printer software features.
8. Select any of the remaining Printer Features options to customize your printouts.
Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Selecting Default Print Settings - PostScript Printer Software - Windows
When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.
1. Do one of the following:

• Windows 10: Right-click and select Control Panel > Hardware and Sound > Devices and
Printers. Right-click your product name and select Printer properties.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name and select Print Preferences.

• Windows 7: Click and select Devices and Printers. Right-click your product name and select
Printing Preferences.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, and select Printing Preferences.

• Windows XP: Click Start and select Printers and Faxes. Right-click your product name and
select Printing Preferences.
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You see the printer settings window:

2. Select the print settings you want to use as defaults in all your Windows programs.
3. Click OK.
These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.
Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Printing with the PostScript (PS3) Printer Software - OS X
You can print with the PostScript (PS3) printer software using any OS X printing program, as described
in these sections.

Note: The PostScript printer software supports products that are connected via Ethernet. If your product
is connected via USB, you will need to install the standard Epson printer software. To download the
standard Epson printer software, go to epson.com/support/wf6090.
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Installing the PostScript (PS3) Printer Software - OS X
Enabling the Optional Paper Cassettes - PostScript Printer Software - OS X
Selecting Basic Print Settings - PostScript Printer Software - OS X
Selecting Page Setup Settings - PostScript Printer Software - OS X
Selecting Print Layout Options - PostScript Printer Software - OS X
Sizing Printed Images - PostScript Printer Software - OS X
Managing Color - PostScript Printer Software - OS X
Printing Your Document or Photo - PostScript Printer Software - OS X
Parent topic: Printing from a Computer

Installing the PostScript (PS3) Printer Software - OS X
If you did not install the standard Epson printer software, you need to install the PostScript (PS3) printer
software before you can adjust the print settings and print to your network printer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software.

1. Download the PS3 Postscript software package from epson.com/support/wf6090.
2. Double-click the downloaded package.
3. Double-click EPSON.
4. Click Continue on the next two screens.
5. Click Agree.
6. Click Install.
7. If necessary, enter the administrator password.
8. Click Start and follow the on-screen instructions.
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Enabling the Optional Paper Cassettes - PostScript Printer Software - OS X
If you installed optional paper cassette units, you need to enable the optional cassette units before you
can use them with the PS3 printer software.
1. In the Apple menu or the Dock, select System Preferences.
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2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

3. Select Driver or Options.
You see a screen like this:

4. Select the number of optional cassettes installed as the Lower Cassette Unit setting.
5. Click OK.
The optional paper cassettes are now enabled.
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X
Related tasks
Enabling the Optional Paper Cassettes - OS X

Selecting Basic Print Settings - PostScript Printer Software - OS X
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
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2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
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You see the expanded printer settings window for your product:

Note: The print window may look different, depending on the version of OS X and the application
you are using.

5. Select the Two-Sided, Copies, and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.
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6. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

8. Select Paper Feed from the pop-up menu.

You see these settings:

9. Select All Pages From or First Page From and select the paper source you want to print from.
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10. Select Printer Features from the pop-up menu.

You see these settings:

11. Select Plain as the MediaType setting.

Note: The PostScript printer software supports plain paper printing on these paper and envelope
sizes:
• A4 (8.3 × 11.7 inches [210 × 297 mm])
• Letter (8.5 × 11 inches [216 × 279 mm])
• No. 10 (4.1 × 9.5 inches [105 × 241 mm])
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12. Select one of the following Print Quality options:
• For fast printing with reduced quality, select Fast.
• For printing text and graphics with good quality and print speed, select Fine.
• For the best printing with reduced speed, select Maximum.

13. Select Color from the Feature Sets pop-up menu.
You see these settings:

14. Select a Color Mode option:
• To print a color document or photo, select the Color setting.
• To print text and graphics in black only, select the Monochrome setting.

15. Select any of the available print options.
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X
Related references
Paper Source Options - OS X
Related tasks
Selecting Page Setup Settings - PostScript Printer Software - OS X
Selecting Print Layout Options - PostScript Printer Software - OS X
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Printing Your Document or Photo - PostScript Printer Software - OS X

Selecting Page Setup Settings - PostScript Printer Software - OS X
Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting. You can also select a custom
setting to create a custom paper size.

2. Select the orientation of your document or photo as shown in the print window.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing with the PostScript (PS3) Printer Software - OS X
Related tasks
Selecting Basic Print Settings - PostScript Printer Software - OS X
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Selecting Print Layout Options - PostScript Printer Software - OS X
You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

• To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

• To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
• To print on both sides of the page, select one of the Two-Sided settings.
• To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X
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Sizing Printed Images - PostScript Printer Software - OS X
You can adjust the size of the image as you print it by selecting Paper Handling from the pop-up menu
on the Print window.

• To print only selected pages in a multi-page document, select an option from the Pages to Print pop-
up menu.

• To adjust the order in which pages are printed, select an option from the Page Order pop-up menu.
• To scale the image to fit on a specific paper size, select the Scale to fit paper size checkbox and

select a paper size from the Destination Paper Size pop-up menu.
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Managing Color - PostScript Printer Software - OS X
You can adjust the Color Matching settings to fine-tune the colors in your printout.
1. Select Color Matching from the pop-up menu in the print window.
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2. Do one of the following:
• To print using standard color profiles for your product and paper to help match image colors,

select ColorSync. Select one of the available Profile options to change the active color profile.
• To use the product's default color matching, select In printer.

Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Printing Your Document or Photo - PostScript Printer Software - OS X
Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.

Checking Print Status - PostScript Printer Software - OS X
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Checking Print Status - PostScript Printer Software - OS X
During printing, you can view the progress of your print job, control printing, and check ink status.
1. Click the printer icon when it appears in the Dock.
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You see the print status window:

2. Select the following options as necessary for your version of OS X:

• To cancel printing, click the print job and click or Delete.

• To pause a print job, click the print job and click or Hold. To resume a print job, click the
paused print job and click or Resume.

• To pause printing for all queued print jobs, click Pause or Pause Printer.
• To display other printer information, click Settings or Supply Levels.

Parent topic: Printing Your Document or Photo - PostScript Printer Software - OS X

Cancelling Printing Using a Product Button
If you need to cancel printing, press the Stop button on your product.
Parent topic: Printing from a Computer
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Replacing Ink Cartridges and Maintenance Boxes
The maintenance box stores ink that gets flushed from the system during print head cleaning. When an
ink cartridge is expended or the maintenance box is at the end of its service life, you need to replace it.
You may also need to replace a cartridge that is more than six months old if your printouts do not look
their best, even after cleaning and aligning the print head.

Note: Please dispose of your used Epson branded ink cartridges and maintenance boxes responsibly
and in accordance with local requirements. If you would like to return your used ink cartridges and
maintenance boxes to Epson for proper disposal, please go to epson.com/recycle for more information.

Check Cartridge and Maintenance Box Status
Purchase Epson Ink Cartridges and Maintenance Box
Removing and Installing Ink Cartridges
Printing with Black Ink and Expended Color Cartridges
Conserving Low Black Ink with Windows
Replacing the Maintenance Box

Check Cartridge and Maintenance Box Status
Your product and its software will let you know when an ink cartridge is low or expended, or when the
maintenance box needs to be replaced.

Note: When using the Epson Universal Print Driver or PostScript (PS3) printer software with the product,
you can check ink cartridge and maintenance box status by using the printer buttons or the utilities
included with the standard Epson printer software. To download the standard Epson printer software, go
to epson.com/support/wf6090.

Checking Cartridge Status on the LCD Screen
Checking Ink and Maintenance Box Status With Windows
Checking Cartridge and Maintenance Box Status with OS X
Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Checking Cartridge Status on the LCD Screen
When one of your cartridges is low, the orange Error light flashes.
When a cartridge is expended, the orange Error light stays on.
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You can use the Ink Levels option to check the status of the cartridges and maintenance box.
1. Press the arrow buttons to select Menu and press the OK button.
2. Select Ink Levels and press the OK button.

You see a screen like this:

Note: The displayed ink and maintenance box levels are approximate.

3. To exit, press the OK button.
Parent topic: Check Cartridge and Maintenance Box Status

Checking Ink and Maintenance Box Status With Windows
You can check your ink or maintenance box status at any time using a utility on your Windows computer.
1. To check your status, access the Windows Desktop, double-click the product icon in the Windows

taskbar, and click Details.
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You see this window:

2. Replace or reinstall the maintenance box or ink cartridge as indicated on the screen.

Note: If any of the ink cartridges installed in the product is broken, incompatible with the product
model, or improperly installed, Epson Status Monitor will not display an accurate ink status.

3. To disable promotional offers, right-click the product icon in the Windows taskbar and select
Monitoring Preferences.
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You see this window:

4. Deselect the Display Epson Offers checkbox.
Parent topic: Check Cartridge and Maintenance Box Status

Checking Cartridge and Maintenance Box Status with OS X
You can check the status of your ink cartridges and maintenance box using a utility on your Mac.
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1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

2. Select EPSON Status Monitor.
You see this window:

3. Do the following as necessary:
• You can update the ink cartridge and maintenance box status by clicking Update.
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• Replace or reinstall the maintenance box or any ink cartridge as indicated on the screen.

Note: If any of the cartridges installed in the product is broken, incompatible with the product model,
or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

Parent topic: Check Cartridge and Maintenance Box Status

Purchase Epson Ink Cartridges and Maintenance Box
You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com/ink3 (U.S. sales) or
epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find
the nearest one, call 800-GO-EPSON (800-463-7766).

Note: This product uses only genuine Epson-brand cartridges. Other brands of ink cartridges and ink
supplies are not compatible and, even if described as compatible, may not function properly.
The cartridges included with the printer are designed for printer setup and not for resale. After some ink
is used for charging, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Ink Cartridge and Maintenance Box Part Numbers
Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Ink Cartridge and Maintenance Box Part Numbers
Use these part numbers when you order or purchase a new maintenance box or ink cartridges.
Maintenance box part number: T671200

Note: For best printing results, use up a cartridge within 6 months after installing it.

Ink color Part number
Standard-capacity High-capacity Extra High-

capacity
Black 748 748XL 748XXL
Cyan 748 748XL 748XXL
Magenta 748 748XL 748XXL
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Ink color Part number
Standard-capacity High-capacity Extra High-

capacity
Yellow 748 748XL 748XXL

Parent topic: Purchase Epson Ink Cartridges and Maintenance Box

Removing and Installing Ink Cartridges
Make sure you have your replacement cartridges handy before you begin. You must install new
cartridges immediately after removing the old ones.

Caution: Leave your old cartridges in the printer until you are ready to replace them to prevent the print
head nozzles from drying out. Do not open ink cartridge packages until you are ready to install the ink.
Cartridges are vacuum packed to maintain reliability.

1. Turn on your product.
2. If an ink cartridge is low or expended, a message appears on your product and on your computer

screen. Note which cartridges need to be replaced.
3. Open the front cover.
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4. Push in the ink cartridge that you want to replace.

The ink cartridge pops out slightly.
5. Pull the ink cartridge out of the slot.

Note: Dispose of used cartridges carefully. Do not take the used cartridge apart or try to refill it.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
Keep ink cartridges out of the reach of children.

164



6. Remove the cartridge from the package.

Caution: Do not touch the green chip on the cartridge. Install the new cartridge immediately after
removing the old one; if you do not, the print head may dry out and be unable to print.

7. Gently shake the ink cartridge horizontally for about five seconds as shown.
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Caution: Do not remove any labels or seals, or ink will leak.

8. Insert the new cartridge into the holder and push it in until it clicks into place.

9. If you see Cartridge Check on the LCD screen, press the OK button to make sure the cartridges are
installed correctly.

10. When you are finished, close the front cover.
The product starts charging the ink and returns to its previous state when finished.

Note: Do not turn off the printer during ink replacement.

Caution: If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and
store it in the same environment as the printer. The valve in the ink supply port is designed to contain
any excess ink, but do not touch the ink supply port or surrounding area. Always store ink cartridges with
the label facing up; do not store cartridges upside-down.

Parent topic: Replacing Ink Cartridges and Maintenance Boxes
Related concepts
Purchase Epson Ink Cartridges and Maintenance Box

Printing with Black Ink and Expended Color Cartridges
When a color ink cartridge is expended, you can temporarily continue printing from your computer using
black ink. Replace the expended color cartridge as soon as possible for future printing.
Printing with Expended Color Cartridges - Windows
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Printing with Expended Color Cartridges - OS X
Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Printing with Expended Color Cartridges - Windows
If you see a message during printing telling you that you can temporarily print in black ink with an
expended color cartridge, you can cancel your print job and select settings to print on plain paper or on
an envelope.

Note: To use this feature, Epson Status Monitor must be enabled.

1. Click Cancel or Cancel Print to cancel your print job.

Note: If the message screen appears on another computer on a network, you may need to cancel
the print job using the product control panel.

2. Load plain paper or an envelope in your product.
3. Access the print settings in your print application.
4. Click the Main tab.
5. Select Plain Paper/Bright White Paper or Envelope as the paper type setting.
6. Select the Black/Grayscale checkbox.
7. Click OK.
8. Print your document.

Epson Status Monitor 3 displays a print message.
9. Click Print in Black to print your document.
Parent topic: Printing with Black Ink and Expended Color Cartridges

Printing with Expended Color Cartridges - OS X
If printing stops, you can cancel your print job and select settings to temporarily print with only black ink
on plain paper or on an envelope.
1. Click the printer icon in the Dock.
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2. If you see a message telling you that you can temporarily print with only black ink, click the Delete or
button to cancel your print job. If you see an error message, click OK.

Note: If the message screen appears on another computer on a network, you may need to cancel
the print job using the product control panel.

3. In the Apple menu or the Dock, select System Preferences.
4. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options

& Supplies.
5. Select Driver or Options.

You see a screen like this:

6. Select On as the Permit temporary black printing setting.
7. Click OK.
8. Close the utility window.
9. Load plain paper or an envelope in your product.
10. Access the print settings in your print application.
11. Select Print Settings from the pop-up menu.
12. Select Plain Paper/Bright White Paper or Envelope as the paper type setting.
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13. Select the Grayscale option.
14. Click Print to print your document.
Parent topic: Printing with Black Ink and Expended Color Cartridges

Conserving Low Black Ink with Windows
The following window appears when black ink runs low and there is more color ink.

Note: The window appears only when you have selected Plain Paper/Bright White Paper as the paper
type setting, and depends on other selected print settings. To use this feature, Epson Status Monitor
must be enabled.

• Click Yes to use a mixture of color inks to create black, or No to continue using the remaining black ink
for the document you are printing.

• Click Disable this feature to continue using the remaining black ink.

Note: If you disable this feature, it remains disabled until you install a new black ink cartridge.

Parent topic: Replacing Ink Cartridges and Maintenance Boxes

Replacing the Maintenance Box
Make sure you have a new maintenance box before you begin.
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Caution: Do not reuse a maintenance box that has been removed and left uninstalled for more than a
week. Keep the maintenance box away from direct sunlight.

1. Make sure the product is not printing.
2. Remove the new maintenance box from its package.

Caution: Do not touch the green chip on the maintenance box. Do not remove the film on the box, or
ink may leak.

3. Open the rear cover 1 (D1).

4. Grasp the maintenance box as shown and pull it out of its holder.
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Note: Do not tilt the used maintenance box or take it apart.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
Keep the maintenance box out of the reach of children and do not drink the ink.

5. Place the used maintenance box in the plastic bag that came with the new maintenance box. Seal
the bag and dispose of it carefully.

6. Insert the new maintenance box into the holder and push it all the way in.

7. Close the rear cover 1 (D1).
Parent topic: Replacing Ink Cartridges and Maintenance Boxes
Related concepts
Purchase Epson Ink Cartridges and Maintenance Box
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Adjusting Print Quality
If your print quality declines, you may need to run a utility to clean or align the print head.

Note: When using the Epson Universal Print Driver or PostScript (PS3) printer software with the product,
you can clean and align the print head and run a nozzle check by using the printer buttons or the utilities
included with the standard Epson printer software. To download the standard Epson printer software, go
to epson.com/support/wf6090.

If running these utilities does not solve the problem, you may need to replace the ink cartridges.
Print Head Maintenance
Print Head Alignment
Cleaning the Paper Guide Rollers

Print Head Maintenance
If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.
You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Print Head Nozzle Check
Print Head Cleaning
Parent topic: Adjusting Print Quality
Related topics
Replacing Ink Cartridges and Maintenance Boxes

Print Head Nozzle Check
You can print a nozzle check pattern to check for clogged nozzles.
Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility
Parent topic: Print Head Maintenance
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Checking the Nozzles Using the Product Control Panel
You can check the print head nozzles using the control panel on your product.
1. Load a few sheets of plain paper in the product.
2. Press the arrow buttons to select Menu and press the OK button.
3. Select Maintenance and press the OK button.

You see this screen:

4. Select Print Head Nozzle Check and press the OK button.
You see a screen like this:

5. Press the up arrow button.
The nozzle pattern prints.
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6. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

7. Do one of the following:
• If there are no gaps, press the down arrow button, select Finish and press the OK button.
• If there are gaps or the pattern is faint, select Clean the print head and press the OK button.

8. Follow the instructions on the screen to clean the print head, check the nozzles, and repeat the
process as necessary.

Caution: Never turn off the product or open the front cover during a cleaning cycle or you may not
be able to print.

If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours without
printing. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges
may be old or damaged and needs to be replaced.
Parent topic: Print Head Nozzle Check
Related concepts
Print Head Cleaning
Related topics
Loading Paper
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Checking the Nozzles Using a Computer Utility
You can check the print head nozzles using a utility on your Windows or Mac computer.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.
• OS X: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &

Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Nozzle Check.
You see a window like this:

5. Click Print.
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6. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

7. If there are no gaps, click Finish.
If there are gaps or the pattern is faint, clean the print head.

Parent topic: Print Head Nozzle Check
Related concepts
Print Head Cleaning
Related topics
Loading Paper

Print Head Cleaning
If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Cleaning the Print Head Using the Product Control Panel
Cleaning the Print Head Using a Computer Utility
Parent topic: Print Head Maintenance
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Related topics
Replacing Ink Cartridges and Maintenance Boxes

Cleaning the Print Head Using the Product Control Panel
You can clean the print head using the control panel on your product.
1. Load a few sheets of plain paper in the product.
2. Press the arrow buttons to select Menu and press the OK button.
3. Select Maintenance and press the OK button.
4. Select Print Head Cleaning and press the OK button.

You see this screen:

5. Press the up arrow button.

Note: Use the nozzle check pattern to determine which colors need cleaning. You can save ink by
cleaning only selected colors.

When the cleaning cycle is finished, you see a message on the screen.

Caution: Never turn off the product or open the front cover during a cleaning cycle or you may not
be able to print.

6. Select Print Nozzle Check Pattern and press the OK button.
7. Press the up arrow button.
8. Select Finish and press the OK button to confirm that the print head is clean.

177



If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours without
printing. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges
may be old or damaged and needs to be replaced.
Parent topic: Print Head Cleaning
Related tasks
Cleaning the Print Head Using a Computer Utility
Related topics
Loading Paper

Cleaning the Print Head Using a Computer Utility
You can clean the print head using a utility on your Windows or Mac computer.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.
• OS X: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &

Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Head Cleaning.
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You see a window like this:

5. Click Start to begin the cleaning cycle.

Caution: Never turn off the product or open the front cover during a cleaning cycle or you may not
be able to print.

6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle
Check Pattern and click Print.

7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean
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Print head needs cleaning

• If there are no gaps, click Finish.
• If there are gaps or the pattern is faint, click Clean to clean the print head again.

If quality still does not improve, one of the ink cartridges may be old or damaged and needs to be
replaced. If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6
hours without printing. Then try cleaning the print head again. If quality still does not improve, one of the
ink cartridges may be old or damaged and needs to be replaced.
Parent topic: Print Head Cleaning

Print Head Alignment
If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using the Product Control Panel
Parent topic: Adjusting Print Quality
Related topics
Loading Paper

Aligning the Print Head Using the Product Control Panel
You can align the print head using the control panel on your product.
1. Load a few sheets of plain paper in the product.
2. Press the arrow buttons to select Menu and press the OK button.
3. Select Maintenance and press the OK button.
4. Select Print Head Alignment and press the OK button.
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5. Do one of the following:
• If vertical lines are misaligned, select Ruled Line Alignment and press the OK button.
• If your printouts look blurry, select Vertical Alignment and press the OK button.
• If you see horizontal bands at regular intervals, select Horizontal Alignment and press the OK

button.
6. Press the up arrow button to print an alignment sheet.

Note: Do not cancel printing while you are printing head alignment patterns.

7. Check the printed patterns on the alignment sheet and do one of the following:
• If you printed a ruled line alignment sheet, select the number representing the pattern with the

least misaligned vertical line.

• If you printed a vertical alignment sheet, select the number representing the most solid printed
pattern for each set on the LCD screen.
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• If you printed a horizontal alignment sheet, select the number representing the pattern with the
least amount of separation or overlap on the LCD screen.

8. After you have selected the number for all the sets, press the OK button.
Parent topic: Print Head Alignment

Cleaning the Paper Guide Rollers
If you see ink on the back of a printout, you can clean the paper guide rollers to remove any excess ink. If
paper does not feed correctly from the rear paper feed slot, you can use a cleaning sheet to clean the
rollers.
1. Do one of the following:

• If printouts are smeared or scuffed, load plain paper in the paper source that you want to clean in
this size: Letter (8.5 × 11 inches [216 × 279 mm])

• If paper does not feed correctly from the rear paper feed slot, load the cleaning sheet that comes
with genuine Epson paper in the rear paper feed slot.

2. Press the arrow buttons to select Menu and press the OK button.
3. Select Maintenance and press the OK button.
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You see this screen:

4. Select Paper Guide Cleaning and press the OK button.
5. Select the paper source you want to clean and press the OK button.
6. Press the up arrow button.
7. Repeat as necessary until the paper comes out clean. If you are using a cleaning sheet, repeat

these steps up to 3 times.

Note: If the paper is not clean after cleaning several times, try cleaning the other paper sources.

Parent topic: Adjusting Print Quality
Related topics
Loading Paper

183



Cleaning and Transporting the Product
If your product gets dirty or you need to move it some distance, follow the instructions in these sections.
Cleaning the Product
Transporting Your Product

Cleaning the Product
To keep your product working at its best, you should clean it several times a year.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it.

1. Turn off the product.
2. Unplug the power cord.
3. Disconnect any connected cables.
4. Remove all the paper from the product.
5. Clean the paper cassettes using a soft brush.
6. Clean the outer case and control panel with a soft, dry cloth. Do not use liquid or chemical cleansers.
Parent topic: Cleaning and Transporting the Product

Transporting Your Product
If you need to store your product or transport it, prepare it for transportation as described here.

Caution: During transportation and storage, follow these guidelines:
• Use two or more people to lift the product.
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• When lifting the product, hold it as shown here. Holding other areas may cause the product to fall or
cause you to pinch your fingers when placing the product down.

• Leave the maintenance box installed; otherwise ink may leak.
• Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.
• Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent

the product from printing.

Note: Before storing your product for a long period, replace low, expended, or expired ink to help
prevent the print head from drying out. Store your product in a cool, dry place.

1. Turn off the product.
2. Unplug the power cord.
3. Disconnect any connected cables.
4. Remove all the paper from the product.
5. Close the paper support and output tray.
6. If you transporting the product a short distance, remove the optional paper cassettes (if they are

installed) before lifting the product.
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7. If you are transporting the product over a long distance, place the product in its original packing
materials, if possible, or use equivalent materials with cushioning around the product. Make sure the
box adequately protects the product control panel.

Keep the product level during transportation. If print quality has declined when you print again, clean and
align the print head.
Parent topic: Cleaning and Transporting the Product
Related concepts
Print Head Cleaning
Print Head Alignment
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Solving Problems
Check these sections for solutions to problems you may have using your product.
Checking for Software Updates
Product Status Messages
Running a Product Check
Resetting Control Panel Defaults
Solving Setup Problems
Solving Network Problems
Solving Copying Problems
Solving Paper Problems
Solving Epson Universal Print Driver/PostScript Problems
Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems
Uninstall Your Product Software
Where to Get Help

Checking for Software Updates
Periodically, it's a good idea to check Epson's support website for free updates to your product software.
Visit the driver download site at (U.S. downloads or Canadian downloads).
• Windows: Your printer software automatically checks for updates. You can also manually update the

software by selecting Software Update here:
• Accessing the Windows Desktop and right-clicking the product icon in the Windows taskbar
• On the Maintenance tab in the printer settings window
You can also update the software by selecting EPSON Software Updater in the EPSON or EPSON
Software program group, accessible by the Start button, or on the Start or Apps screens, depending
on your version of Windows.

• OS X: You can manually update the software by opening the Applications > Epson Software folder
and selecting EPSON Software Updater.

Parent topic: Solving Problems
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Product Status Messages
You can often diagnose problems with your product by checking the messages on its LCD screen.

LCD screen message Condition/solution
Printer error. Turn the power off and Turn the product off and then back on again. If the error
on again. continues, check for and remove any paper jams or protective

materials from the product. If the error is still displayed, contact
Epson for support.

Printer error. The product may be damaged. Contact Epson for support. Non-
printing features are available.

Too many paper cassette units are You can install up to three optional paper cassette units.
installed. Turn the power off and Remove any extra units.
uninstall the extra units.
Cannot print because XX is out of Turn the product off and then back on again. Reinsert the
order. You can print from another indicated paper cassette.
paper source.
Maintenance rollers on XX are The maintenance rollers need to be replaced periodically for
nearing the end of their service life. optimal performance. (Paper may not feed correctly from the

paper cassette when the maintenance roller is near the end of its
service life.)

Maintenance rollers on XX are at the Contact Epson for support.
end of their service life.
You need to replace the following ink Replace the ink cartridge indicated on the LCD screen.
cartridge(s).
Memory full Reduce the size of the print job.
Invalid IP address and subnet mask. There is a problem with the network connection to your product.
Recovery mode An error has occurred during firmware updating. Connect your

product using a USB cable and try downloading the Firmware
Update from the Epson support site. If you still need help,
contact Epson for support.

Parent topic: Solving Problems
Related references
Where to Get Help
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Related tasks
Checking for Software Updates
Related topics
Replacing Ink Cartridges and Maintenance Boxes
Solving Paper Problems
Wi-Fi or Wired Networking

Running a Product Check
Running a product check helps you determine if your product is operating properly.
1. Disconnect any interface cables connected to your product.
2. Load plain paper in the product.
3. Press the arrow buttons to select Menu and press the OK button.
4. Select Maintenance and press the OK button.

You see this screen:

5. Select Print Head Nozzle Check and press the OK button.
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You see a screen like this:

6. Press the up arrow button.
The nozzle pattern prints.

7. Do one of the following, depending on the results of the product check:
• If the page prints and the nozzle check pattern is complete, the product is operating properly. Any

operation problem you may have could be caused by your computer, cable, software, or selected
settings. Check the other solutions in this book or try uninstalling and reinstalling your printer
software.

• If the page prints but the nozzle check pattern has gaps, clean or align the print head.
• If the page does not print, the product may have a problem. Check for other solutions. If they do

not work, contact Epson.
Parent topic: Solving Problems
Related concepts
Print Head Cleaning
Print Head Alignment
Uninstall Your Product Software
Related references
Where to Get Help

Resetting Control Panel Defaults
If you have a problem with settings on the product control panel, you can reset them to their factory
defaults. You can choose which settings to reset or reset them all.
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Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the arrow buttons to select Menu and press the OK button.
2. Select System Administration and press the OK button. Enter the administrator password, if

necessary.
3. Select Restore Default Settings and press the OK button.

You see this screen:

4. Select one of these options and press the OK button:
• Network Settings: Resets all network settings.
• Clear All Data and Settings: Resets all control panel settings.
You see a confirmation screen.

5. Press the up arrow button to reset the selected settings. (Press the down arrow button if you want to
cancel the operation.)

Parent topic: Solving Problems

Solving Setup Problems
Check these sections if you have problems while setting up your product.
Product Does Not Turn On or Off
Noise After Ink Installation
Software Installation Problems
Parent topic: Solving Problems
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Product Does Not Turn On or Off
If you cannot turn the product on or off, try these solutions:
• If you cannot turn on your product, make sure the power cord is securely connected and hold down

the power button a little longer.
• If you cannot turn off your product, hold down the power button a little longer. If you still cannot turn off

your product, unplug the power cord, plug the power cord back in, then turn your product on and off
again using the power button.

Parent topic: Solving Setup Problems

Noise After Ink Installation
If you hear noises from your product after installing ink, check the following:
• The first time you install the ink cartridges, the product must charge its print head. Wait until charging

finishes before you turn off the product, or it may charge improperly and use excess ink the next time
you turn it on.

• If the product's print head stops moving or making noise, and the charging process has not finished
after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still
in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems

Software Installation Problems
If you have problems while installing your product software, try these solutions:
• Make sure your product is turned on and any necessary cables are securely connected at both ends. If

you still have problems installing software, disconnect the cable and carefully follow the instructions on
the Start Here sheet. Also make sure your system meets the requirements for your operating system.

• Close any other programs, including screen savers and virus protection software, and install your
product software again.

• In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

• If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your System Administrator.

• If you are printing over a network, make sure your product is set up properly on the network.
Parent topic: Solving Setup Problems
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Related concepts
Uninstall Your Product Software
Related references
Windows System Requirements
OS X System Requirements

Solving Network Problems
Check these solutions if you have problems setting up or using your product on a network.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not
responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your network data and settings.

Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network
Product Does Not Appear in OS X Printer Window
Cannot Print Over a Network
Parent topic: Solving Problems

Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions:
• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your

product's LCD screen is not lit or does not appear, make sure you select one of the WPS options from
the product control panel within 2 minutes of pressing the WPS button on your router.

• Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid
placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a
filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

• Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.

• You may need to disable the firewall and any anti-virus software on your wireless router or access
point.
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• Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. To
obtain your product's MAC address, print a network status sheet. Then follow the instructions in your
router or access point documentation to add the address to the list.

• If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.

• If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.

• Check if your computer is restricting the available wireless channels. If so, verify that your wireless
access point is using one of the usable channels and change to a usable channel, if necessary.

• If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on
your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxx connection
settings from your device and enter a new password. See your device documentation for instructions.

• If you connected your product to a Windows computer using Wi-Fi Direct and it automatically selected
Access Point Mode, you may have trouble accessing a low-priority Internet connection. Check the
network connection or adapter settings in the Windows Control Panel and set the Internet metric
setting to 100 for your version of the Internet Protocol.

Parent topic: Solving Network Problems
Related concepts
Wi-Fi Direct Mode Setup
Related tasks
Selecting Wireless Network Settings From the Control Panel
Printing a Network Status Sheet
Related topics
Wi-Fi or Wired Networking

Network Software Cannot Find Product on a Network
If EpsonNet Setup cannot find your product on a network, try these solutions:
• Make sure your product is turned on and connected to your network. Verify connection using your

product control panel.
• Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-

ASCII characters.
• Make sure your product is not connected to a guest network.
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• If necessary, reinstall your product software and try running EpsonNet Setup again:
1. Reset your product's network settings to their factory defaults.
2. Windows only: uninstall your product software.
3. Initialize your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
initialize your router, so note the next step before initializing it.

4. Download your product software from the Epson website using the instructions on the Start Here
sheet.

• If you have replaced your router, reinstall your product software to connect to the new router.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

Parent topic: Solving Network Problems
Related concepts
Uninstall Your Product Software
Related topics
Wi-Fi or Wired Networking

Product Does Not Appear in OS X Printer Window
If your product does not appear in the OS X printer window, try these solutions:
• Turn your product off, wait 30 seconds, then turn it back on again.
• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon does not appear

on your product's LCD screen, make sure you select one of the WPS options from the product control
panel within 2 minutes of pressing the WPS button on your router.

• If you are connecting the product wirelessly via EpsonNet Setup and the Wi-Fi icon does not appear
on your LCD screen, make sure your product software was installed correctly. If necessary, reinstall
your software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

Parent topic: Solving Network Problems
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Related concepts
Uninstall Your Product Software

Cannot Print Over a Network
If you cannot print over a network, try these solutions:
• Make sure that your product is turned on.
• Make sure you install your product's network software as described in your product documentation.
• Print a network status sheet and verify that the network settings are correct. If the network status is

Disconnected, check any cable connections and turn your product off and then on again.
• If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your

network does not assign IP addresses using DHCP, set the IP address manually.
• Make sure your computer and product are both using the same wireless network.
• If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place

your product closer to your router or access point. Avoid placing your product near a microwave oven,
2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

• Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing printing from a device over the network. See your router or access point documentation for
instructions on disabling the Privacy Separator function.

• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon does not appear
on your product's LCD screen, make sure you select one of the WPS options from the product control
panel within 2 minutes of pressing the WPS button on your router.

• Check your wired LAN router or access point to see if the LED for the port to which your product is
connected is on or flashing. If the link LED is off, try the following:
• Make sure the Ethernet cable is securely connected to your product and to your router, access

point, switch, or hub.
• Try connecting your product to a different port or a different router, access point, switch, or hub.
• Try connecting with a different Ethernet cable.
• Try printing to your product from another computer on the network.
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Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

• If you are connecting the product via EpsonNet Setup and the Wi-Fi icon does not appear on the LCD,
make sure your product software was installed correctly. If necessary, reinstall your software.

Parent topic: Solving Network Problems
Related concepts
Uninstall Your Product Software
Related tasks
Printing a Network Status Sheet
Related topics
Wi-Fi or Wired Networking

Solving Copying Problems
Check these solutions if you have problems copying with your product.
Product Makes Noise, But Nothing Copies
Product Makes Noise When It Sits for a While
Parent topic: Solving Problems

Product Makes Noise, But Nothing Copies
If your product makes a noise, but nothing copies, try these solutions:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• If the nozzle check page does not print, but the product's power is on, make sure your product

software is installed correctly.
• Make sure your product is level (not tilted).
Parent topic: Solving Copying Problems

Product Makes Noise When It Sits for a While
Your product is performing routine maintenance. This is normal.
Parent topic: Solving Copying Problems
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Solving Paper Problems
Check these sections if you have problems using paper with your product.
Paper Feeding Problems
Paper Jam Problems in the Front Cover (A)
Paper Jam Problems in the Rear Paper Feed Slot (B1)
Paper Jam Problems in the Front Paper Feed Slot (B2)
Paper Jam Problems in the Cassette (C1/C2/C3)
Paper Jam Problems in the Rear Cover 1 (D1)
Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
Paper Ejection Problems
Parent topic: Solving Problems

Paper Feeding Problems
If you have problems feeding paper, try these solutions:
• If paper does not feed for printing, remove it from the rear feed slot or cassette. Reload it, then adjust

the edge guides. Make sure the paper stack is not above the tab on the edge guides inside the
cassette or rear feed slot.

• If paper does not feed from the rear feed slot, try cleaning the paper guide using an Epson cleaning
sheet.

• Be sure to insert the paper cassette all the way into your product.
• If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
• If multiple pages continue to feed at once, turn on the Paper Feed Assist Mode setting in the Setup >

System Administration > Printer Settings menu.
• Do not load more than the recommended number of sheets.
• Make sure your paper meets the specifications for your product.
• If paper jams when you print on both sides of the paper, try loading fewer sheets.
• Make sure the paper size and paper type settings are correct for the paper source.
• If you installed an optional paper cassette unit, be sure to enable the cassette unit in the printing

software.
• If your product pauses during printing, make sure the front cover is closed.
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• For best results, follow these guidelines:
• Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
• Load paper in the cassette printable side down.
• Do not load binder paper with holes in the cassette.
• Follow any special loading instructions that came with the paper.

Parent topic: Solving Paper Problems
Related references
Paper Jam Problems in the Front Cover (A)
Paper Jam Problems in the Rear Paper Feed Slot (B1)
Paper Jam Problems in the Front Paper Feed Slot (B2)
Paper Jam Problems in the Cassette (C1/C2/C3)
Paper Jam Problems in the Rear Cover 1 (D1)
Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
Paper Loading Capacity
Paper Specifications
Related tasks
Cleaning the Paper Guide Rollers
Related topics
Loading Paper

Paper Jam Problems in the Front Cover (A)
If paper has jammed in the front cover, follow the steps here to clear the jam.
1. Cancel the print job, if necessary.
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2. Open the front cover.

3. Remove any paper inside, including torn pieces.

Caution: Be careful to not touch any parts inside the product to prevent damage to it.

4. Close the front cover.
5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam

message, check the other paper jam solutions.
Parent topic: Solving Paper Problems
Related references
Paper Jam Problems in the Rear Paper Feed Slot (B1)
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Paper Jam Problems in the Front Paper Feed Slot (B2)
Paper Jam Problems in the Cassette (C1/C2/C3)
Paper Jam Problems in the Rear Cover 1 (D1)
Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit

Paper Jam Problems in the Rear Paper Feed Slot (B1)
If paper has jammed in the rear paper feed slot, carefully remove the paper.

Parent topic: Solving Paper Problems
Related references
Paper Jam Problems in the Front Cover (A)
Paper Jam Problems in the Front Paper Feed Slot (B2)
Paper Jam Problems in the Cassette (C1/C2/C3)
Paper Jam Problems in the Rear Cover 1 (D1)
Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit

Paper Jam Problems in the Front Paper Feed Slot (B2)
If paper has jammed in the front paper feed slot, follow the steps here to clear the jam.
1. Cancel the print job, if necessary.
2. Close the output tray.
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3. Remove the output tray and pull out the paper cassette.

4. Pull the lever to lower the cover.
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5. Carefully remove any paper jammed inside the product.

6. Raise the cover.

7. Reattach the output tray and insert the paper cassette.
8. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam

message, check the other paper jam solutions.
Parent topic: Solving Paper Problems
Related references
Paper Jam Problems in the Front Cover (A)
Paper Jam Problems in the Rear Paper Feed Slot (B1)
Paper Jam Problems in the Cassette (C1/C2/C3)
Paper Jam Problems in the Rear Cover 1 (D1)
Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
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Paper Jam Problems in the Cassette (C1/C2/C3)
If paper has jammed in the cassette, follow the steps here to clear the jam.

Note: If the optional paper cassettes are installed, do not remove more than one paper cassette at a
time.

1. Cancel the print job, if necessary.
2. Pull out the paper cassette.
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3. Carefully remove any paper jammed inside the product.

4. Carefully follow all paper loading instructions and reload the paper.
5. Keep the cassette flat as you gently insert it.
6. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam

message, check the other paper jam solutions.
Parent topic: Solving Paper Problems
Related references
Paper Jam Problems in the Front Cover (A)
Paper Jam Problems in the Rear Paper Feed Slot (B1)
Paper Jam Problems in the Front Paper Feed Slot (B2)
Paper Jam Problems in the Rear Cover 1 (D1)
Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit

Paper Jam Problems in the Rear Cover 1 (D1)
If paper has jammed in the rear cover 1, follow the steps here to clear the jam.
1. Cancel the print job, if necessary.
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2. Open rear cover 1 (D1).

3. Carefully remove any jammed paper.

Caution: Do not touch the paper feed mechanism.
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4. Pull out rear cover 2 (D2).

5. Remove any jammed paper from the duplexer.

6. Replace rear cover 2 (D2).
7. Close rear cover 1 (D1).
8. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam

message, check the other paper jam solutions.
Parent topic: Solving Paper Problems
Related references
Paper Jam Problems in the Front Cover (A)
Paper Jam Problems in the Rear Paper Feed Slot (B1)
Paper Jam Problems in the Front Paper Feed Slot (B2)
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Paper Jam Problems in the Cassette (C1/C2/C3)
Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit

Paper Jam Problems in the Rear Cover (E) of the Optional Paper Cassette Unit
If paper has jammed in any of the optional paper cassettes, follow the steps here to clear the jam.
1. Cancel the print job, if necessary.
2. Open rear cover (E) on the optional paper cassette unit with the jammed paper.

3. Carefully remove any paper jammed inside.

4. Close rear cover (E).
5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam

message, check the other paper jam solutions.
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Parent topic: Solving Paper Problems
Related references
Paper Jam Problems in the Front Cover (A)
Paper Jam Problems in the Rear Paper Feed Slot (B1)
Paper Jam Problems in the Front Paper Feed Slot (B2)
Paper Jam Problems in the Cassette (C1/C2/C3)
Paper Jam Problems in the Rear Cover 1 (D1)

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:
• If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper.

Select the correct paper size when you reprint.
• If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select

the correct paper type setting when you reprint.
Parent topic: Solving Paper Problems
Related references
Paper or Media Type Settings - Printing Software
Related tasks
Cancelling Printing Using a Product Button
Related topics
Loading Paper

Solving Epson Universal Print Driver/PostScript Problems
Check these sections if you have problems with the Epson Universal Print Driver or PostScript printer
software.
Nothing Prints Using the Postscript Printing Software
Documents Print Incorrectly Using the Postscript Printing Software
Accessing Printer Properties - Postscript - Windows
Parent topic: Solving Problems
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Nothing Prints Using the Postscript Printing Software
If your document doesn't print, try these solutions:
• Make sure your product is turned on and properly connected.
• Make sure the printing language setting on the control panel is correct.
• If Text Detection is enabled on the control panel and you cannot print text, set the printing language

to PS3.
• Make sure your product is selected as the printer in your printing program.
• In Windows, the product may not print if a large number of print jobs are sent. Try selecting Print

directly to the printer on the Advanced tab in the printer properties.
Parent topic: Solving Epson Universal Print Driver/PostScript Problems
Related topics
Printing with the Epson Universal Print Driver - Windows

Documents Print Incorrectly Using the Postscript Printing Software
If your document does not print correctly, try these solutions:
• If the file you are printing was created in an application that allows you to change the data format, such

as Adobe Photoshop, make sure the settings in the application match the printer software settings.
• EPS files created in binary format may not print correctly. Try creating the file in ASCII format instead.
• In Windows, the product cannot print binary data if it is connected to the computer using a USB cable.

Try selecting ASCII or TBCP as the Output Protocol setting on the Device Settings tab in the printer
properties.

• In Windows, select the appropriate substitution fonts on the Device Settings tab in the printer
properties.

• If the printed colors are incorrect, try adjusting the Color Mode setting on the Advanced tab of the
printer software.

• If printing is slow, try selecting Fast as the Print Quality setting on the Advanced tab of the printer
software.

Parent topic: Solving Epson Universal Print Driver/PostScript Problems
Related tasks
Accessing Printer Properties - Postscript - Windows
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Accessing Printer Properties - Postscript - Windows
You can access the printer properties to view and change product settings.
1. Do one of the following:

• Windows 10: Right-click and select Control Panel > Hardware and Sound > Devices and
Printers. Right-click your product name and select Printer properties.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click the postscript driver for your product, and select Printer
properties.

• Windows 7: Click and select Devices and Printers. Right-click the postscript driver for your
product and select Printer properties.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
then right-click the postscript driver for your product and select Properties.

• Windows XP: Click Start and select Printers and Faxes. Right-click the postscript driver for your
product and select Properties.

2. Click any tab to view and change the printer property settings.
Parent topic: Solving Epson Universal Print Driver/PostScript Problems

Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Note: For problems while printing with the Epson Universal Print Driver or PostScript (PS3) printer
software, see the sections covering that software in this manual.

Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Printing is Slow
Parent topic: Solving Problems
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Nothing Prints
If you have sent a print job and nothing prints, try these solutions:
• Make sure your product is turned on.
• Make sure any interface cables are connected securely at both ends.
• If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,

connect your product directly to your computer instead of the hub.
• Run a product check to see if a test page prints. If the test page prints, check to see if your product

software is installed correctly.
• If you are printing a large image, the computer may not have enough memory. Print the image at a

lower resolution or a smaller file size.
• In Windows, click Print Queue on the Maintenance tab in the printer settings window and check for

the following:
• Check for any stalled or paused print jobs. Cancel or unpause any jobs as necessary.
• Open the Printer menu and make sure the product is not offline.
• Open the Printer menu and set the product as the default printer, if necessary.

• In OS X, select System Preferences from the Apple menu or Dock, select Print & Scan or Printers
& Scanners, then double-click your printer icon. Check to see if any jobs are paused. Cancel or
resume any jobs as necessary.

• If the user restriction feature (Access Control) is enabled, a user ID and password is required to print.
If you do not know the user ID or password, contact your administrator for assistance.

Note: In OS X, you may not be able to print if the user restriction feature is enabled. Contact your
administrator for assistance.

• If you are using AirPrint, make sure AirPrint is enabled with the correct settings using Web Config.
Parent topic: Solving Problems Printing from a Computer
Related tasks
Using AirPrint
Running a Product Check

212



Product Icon Does Not Appear in Windows Taskbar
If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:
1. Do one of the following:

• Windows 10: Right-click and select Control Panel > Hardware and Sound > Devices and
Printers.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers.

• Windows 7: Click and select Devices and Printers.

• Windows Vista: Click , select Control Panel, and click Printer under Hardware and Sound.
• Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select

Printers and Other Hardware, if necessary, and Printers and Faxes.)
2. Right-click your product name, select Printing Preferences, and select your product name again if

necessary.
3. Click the Maintenance tab.
4. Click the Extended Settings button.
5. Select Enable EPSON Status Monitor 3, then click OK.
6. Click the Monitoring Preferences button.
7. Click the checkbox for the option that adds the shortcut icon to the taskbar.
8. Click OK to close the open program windows.
Parent topic: Solving Problems Printing from a Computer

Printing is Slow
If printing becomes slow, try these solutions:
• Make sure your system meets the requirements for your operating system. If you are printing a high-

resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.

• If you are using Windows 7, close the Devices and Printers window before you print.
• If you are using OS X, make sure you download and install the Epson printer driver.
• Make sure Quiet Mode is turned off.
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• Clear space on your hard drive or run a defragmentation utility to free up existing space.
• Close any programs you are not using when you print.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If printing becomes slower after printing continuously for a long time, the product may have

automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.

For the fastest printing, select the following settings in your product software:
• Make sure the paper type setting matches the type of paper you loaded.
• Turn on any high speed settings in your product software.
• Select a lower print quality setting.
• Make sure the ink drying time has not been increased for double-sided printing.
• Windows: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress,

and select the following settings:
• High Speed Copies
• Always Spool RAW Datatype
• Page Rendering Mode
• Print as Bitmap

Parent topic: Solving Problems Printing from a Computer
Related references
Windows System Requirements
OS X System Requirements
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - OS X

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.
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Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Inverted Image
Too Many Copies Print
Blank Pages Print
Incorrect Margins on Printout
Incorrect Characters Print
Incorrect Image Size or Position
Slanted Printout
Parent topic: Solving Problems

Inverted Image
If your printed image is inverted unexpectedly, try these solutions:
• Turn off any mirror or inversion settings in your printing application.
• Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer

software. (This option has different names, depending on your operating system version.)

Note: Leave these options turned on when you print on Epson Iron-on Cool Peel Transfer paper, if
available for your product.

Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - OS X
Selecting Additional Layout and Print Options - Windows

Too Many Copies Print
Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X
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Blank Pages Print
If blank pages print unexpectedly, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• If a blank page exists in a document you are printing and you want to skip printing it, select the Skip

Blank Page setting in your printer software.
• Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if

necessary.
• Make sure your product is selected as the printer in your printing program.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - OS X
Selecting Extended Settings - Windows
Selecting Basic Print Settings - Windows
Selecting Printing Preferences - OS X

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• Make sure you selected the correct margins for your paper size in your printing program.
• Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X
Related topics
Loading Paper

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
• Make sure any cables are securely connected at both ends.
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• In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in
the printer settings window, and cancel any stalled print jobs.

• If your product is connected to a USB hub, connect it directly to your computer instead.
• If your computer entered sleep mode the last time you printed, the next print job after your computer

exits sleep mode may contain garbled characters. Print your document again.
• If incorrect characters still appear in your prints, try connecting your product using a different cable.
Parent topic: Solving Page Layout and Content Problems

Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:
• Make sure you selected the correct paper size and layout settings in your printing program and printer

software.
• Make sure you selected the correct paper size on the control panel.
• Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - OS X
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - OS X
Selecting Page Setup Settings - OS X

Slanted Printout
If your printouts are slanted, try these solutions:
• Slide the edge guides against the edges of the paper.
• Select a higher print quality setting in your printer software.
• Turn off any high speed settings in your product software.
• Align the print head.
• Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems
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Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X
Related topics
Loading Paper

Solving Print Quality Problems
Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

White or Dark Lines in Printout
Blurry or Smeared Printout
Faint Printout or Printout Has Gaps
Grainy Printout
Incorrect Colors
Parent topic: Solving Problems

White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
• Turn off any high speed settings in your product software.
• Align the print head.
• You may need to replace the ink cartridges.
Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
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Print Head Cleaning
Print Head Alignment
Related references
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Printing Preferences - OS X
Related topics
Loading Paper
Replacing Ink Cartridges and Maintenance Boxes

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Use a support sheet with special paper, or load special paper one sheet at a time.
• Make sure your paper meets the specifications for your product.
• Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
• Make sure the paper type setting in your product software matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
• If you are printing on thick paper or envelopes, turn on the Thick Paper setting from the control panel

or select Thick Paper and Envelopes in the Extended Settings of the printer software. (Turning this
setting on will decrease print speed.)

• In Windows, if the paper is still smeared after selecting the Thick Paper and Envelopes setting,
select the Short Grain Paper setting in the Extended Settings of the printer software.

• Remove each sheet from the output tray as it is printed.
• Avoid handling printouts on glossy paper right after printing to allow the ink to set.
• Turn off any high speed settings in your product software.
• If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily

saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.
Adjust the Print Density and/or Increase Ink Drying Time settings.

• If printed copies are smeared, lower the copy density setting on the product control panel.
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• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

• Align the print head.
• Clean the paper path.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems
Related concepts
Print Head Cleaning
Print Head Alignment
Related references
Available Epson Papers
Paper Specifications
Double-sided Printing Options - Windows
Related tasks
Selecting Basic Print Settings - OS X
Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting Printing Preferences - OS X
Selecting Double-sided Printing Settings - OS X
Selecting Printing Preferences - OS X
Cleaning the Paper Guide Rollers
Related topics
Loading Paper

Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• The ink cartridges may be old or low on ink, and you may need to replace them.
• Make sure the paper type setting matches the type of paper you loaded.
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• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Align the print head.
• Clean the paper path.
Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Related references
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Basic Print Settings - OS X
Selecting Basic Print Settings - Windows
Cleaning the Paper Guide Rollers
Related topics
Replacing Ink Cartridges and Maintenance Boxes
Loading Paper

Grainy Printout
If your printouts are grainy, try these solutions:
• Make sure you loaded the printable side of the paper correctly for your product.
• Select a higher print quality setting and turn off any high speed settings in your product software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Align the print head.
• You may need to increase the image resolution or print a smaller size; see your software

documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.

• If you enlarged the image in an image-editing program, you need to increase the resolution setting to
retain a high image quality. Increase the resolution by the same amount you increased the image size.
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For example, if the resolution is 300 dpi (dots per inch) and you will double the image size later,
change the resolution setting to 600 dpi.

Note: Higher resolution settings result in larger file sizes, which take longer to process and print.
Consider the limitations of your computer system when selecting a resolution, and select the lowest
possible resolution that produces acceptable quality to keep file sizes manageable.

Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Additional Layout and Print Options - Windows
Related topics
Loading Paper

Incorrect Colors
If your printouts have incorrect colors, try these solutions:
• Make sure the paper type setting matches the paper you loaded.
• Make sure the Black/Grayscale or Grayscale setting is not selected in your printer software.
• If you selected Standard-Vivid (Windows) or Normal-Vivid (OS X) as the quality setting in the printer

software, try selecting Standard (Windows) or Normal (OS X) instead.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• The ink cartridges may be old or low on ink, and you may need to replace them.
• After you print, the colors in your printout need time to set as the ink dries. During this time, the colors

may look different than you expect. To speed up drying time, do not stack your printouts on top of each
other.

• Your printed colors can never exactly match your on-screen colors. However, you can use a color
management system to get as close as possible. Try using the color management options in your
printer software.
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• For best results, use genuine Epson ink and paper.
Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Related references
Available Epson Papers
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Additional Layout and Print Options - Windows
Related topics
Replacing Ink Cartridges and Maintenance Boxes

Uninstall Your Product Software
If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.
Uninstalling Printing Software - Windows
Uninstalling Product Software - OS X
Parent topic: Solving Problems

Uninstalling Printing Software - Windows
You can uninstall and then re-install your printer software to solve certain problems.
1. Turn off the product.
2. Disconnect any interface cables.
3. Do one of the following:

• Windows 10: Right click and select Control Panel > Programs > Programs and Features.
Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.
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Select your product again, if necessary, then select OK, and click Yes to confirm the
uninstallation.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product, if necessary, and click OK. Then follow any on-screen
instructions.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product, if necessary, and click OK. Then follow any on-screen
instructions.

4. Restart your computer, then re-install your software.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Product Software

Uninstalling Product Software - OS X
In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit the Epson download site (U.S. downloads or Canadian
downloads).

2. Follow the instructions on the screen to install the Uninstaller utility.
3. Quit all applications currently running on your Mac.
4. Double-click the Uninstaller icon.
5. Select the checkbox for each software program you want to uninstall.
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6. Click Uninstall.
7. Follow the on-screen instructions to uninstall the software.
8. To reinstall your product software, see the Start Here sheet for instructions.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax, Print & Scan,
or Printers & Scanners window, select your product name and click the – (remove) icon to remove it.

Parent topic: Uninstall Your Product Software

Where to Get Help
If you need to contact Epson for technical support services, use the following support options.

Internet Support
Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for solutions to
common problems. You can download drivers and documentation, get FAQs and troubleshooting
advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem
Then call:
• U.S.: (562) 276-7202, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific

Time, Saturday
• Canada: (905) 709-2567, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM,

Pacific Time, Saturday
Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.
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Purchase Supplies and Accessories
You can purchase genuine Epson ink and paper at epson.com/ink3 (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call
800-GO-EPSON (800-463-7766).
Parent topic: Solving Problems
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Technical Specifications
These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site for
information on how to return your Epson products for proper disposal.

Windows System Requirements
OS X System Requirements
Paper Specifications
Printable Area Specifications
Ink Cartridge Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
Network Interface Specifications
Safety and Approvals Specifications
PostScript Fonts
PCL Fonts
Symbol Sets

Windows System Requirements
To use your product and its software, your computer should use one of these Microsoft operating
systems:
• Windows 10
• Windows 8.x
• Windows 7
• Windows Vista
• Windows XP Professional x64 Edition
• Windows XP SP3
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Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

OS X System Requirements
To use your product and its software, your Mac should use one of these operating systems:
• OS X 10.10.x
• OS X 10.9.x
• OS X 10.8.x
• OS X 10.7.x
• OS X 10.6.8

Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

Paper Specifications
Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a
sample of paper stock before purchasing large quantities or printing large jobs.

Single-sheets

Paper types Plain paper and paper distributed by Epson
Weight Plain paper: 17 lb (64 g/m2) to 24 lb (90 g/m2)

Thick paper: 25 lb (91 g/m2) to 68 lb (256 g/m2)

Envelopes

Size No. 10 (4.1 × 9.5 inches [105 × 241 mm])
Weight 20 lb (75 g/m2) to 24 lb (90 g/m2)
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Parent topic: Technical Specifications

Printable Area Specifications
Note: Print quality may decline in the shaded areas shown here.

Single sheets

1 Top/bottom/sides: 0.12 inch (3 mm) minimum
2 Reduced print quality area/top: 1.81 inch (46 mm) minimum
3 Reduced print quality area/bottom: 2.01 inches (51 mm) minimum
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Envelopes

1 Sides: 0.12 inch (3 mm) minimum
2 Top/bottom: 0.20 inch (5 mm) minimum
3 Reduced print quality area/right: 2.01 inches (51 mm) minimum
4 Reduced print quality area/left: 1.81 inch (46 mm) minimum

Parent topic: Technical Specifications

Ink Cartridge Specifications
Note: This product uses only genuine Epson-brand cartridges. Other brands of ink cartridges and ink
supplies are not compatible and, even if described as compatible, may not function properly.
The cartridges included with the printer are designed for printer setup and not for resale. After some ink
is used for charging, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Color Cyan, Magenta, Yellow, Black
Cartridge life Opened package: 6 months

Unopened package: do not use if the date on the package has
expired
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Temperature Storage: 4 to 104 °F (-20 to 40 °C)
1 month at 104 °F (40 °C)
Ink freezes at -9.4 °F (-23 °C)
Ink thaws and is usable after 3 hours at 77 °F (23 °C)

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Parent topic: Technical Specifications

Dimension Specifications
Printer Only

Height Stored: 15.9 inches (404 mm)
Printing: 21.3 inches (540 mm)

Width Stored: 18.8 inches (478 mm)
Printing: 18.8 inches (478 mm)

Depth Stored: 20.6 inches (522 mm)
Printing: 29.8 inches (756 mm)

Weight 50.7 lb (23 kg)
(without ink cartridges or power
cord)

Printer with Optional Cassettes (2)

Height Stored: 26 inches (660 mm)
Printing: 31.3 inches (796 mm)

Width Stored: 18.8 inches (478 mm)
Printing: 18.8 inches (478 mm)

Depth Stored: 20.7 inches (527 mm)
Printing: 29.8 inches (756 mm)

231



Weight 90.8 lb (41.2 kg)
(without ink cartridges or power
cord)

Parent topic: Technical Specifications

Electrical Specifications
Power supply rating 100 to 240 V
Rated frequency range 50/60 Hz
Rated current 1.0 - 0.5 A
Power consumption (with USB Printing: Approx. 33 W (ISO/IEC24712)
connection) Ready mode: Approx. 8.1 W

Sleep mode: Approx. 2.5 W
Power off mode: Approx. 0.5 W

Parent topic: Technical Specifications

Environmental Specifications
Temperature Operating: 50 to 95 °F (10 to 35 °C)

Storage: –4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Humidity Operating: 20 to 80% RH
(without condensation) Storage: 5 to 85% RH

Parent topic: Technical Specifications

Interface Specifications
Interface type Hi-Speed USB (for computer)

Parent topic: Technical Specifications
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Network Interface Specifications
Wi-Fi

Standard IEEE 802.11 b/g/n; complies with either IEEE 802.11 b/g or IEEE
802.11 b/g/n, depending on purchase location

Security WEP (64/128 bit)
WPA2-PSK (AES); complies with WPA2 with support for
WPA/WPA2 Personal
WPA2-Enterprise

Frequency range 2.4 GHz
Coordination modes Infrastructure mode

Ad hoc mode; no supported by IEEE 802.11 n
Wi-Fi Direct; not supported for IEEE 802.11b

Note: Wi-Fi Direct Simple AP mode available with a Wi-Fi
infrastructure or Ethernet connection.

Ethernet

Standards IEEE802.3i (10BASE-T)
IEEE802.3u (100BASE-TX)
IEEE802.3ab (1000BASE-T)
IEEE802.3az (Energy Efficient Ethernet); connected device should
be IEEE802.3az compliant

Communication mode Auto, 10Mbps Full duplex, 10Mbps Half duplex, 100Mbps Full
duplex, 100Mbps Half duplex

Connector RJ-45

Note: Use a category 5e or higher STP (shielded twisted pair) cable to prevent risk of radio interference.

Security Protocol
IEEE802.1X; connected device must be IEEE802.1X compliant
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IPsec/IP Filtering
SSL/TLS: HTTPS Server/Client or IPPS
STARTTLS (SMTPS)
SNMPv3
Parent topic: Technical Specifications

Safety and Approvals Specifications
United States Safety: UL60950-1

EMC: FCC part 15 Subpart B class B
Canada Safety: CAN/CSA C22.2 No. 60950-1

EMC: CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module:
• Manufacturer: Askey Computer Corporation.
• Type: WLU6320-D69 (RoHS)
This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.
To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.
This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment
and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102
of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that
the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities:
hands, wrists, feet and ankles).
Parent topic: Technical Specifications
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PostScript Fonts
Font name Family HP equivalent
Nimbus Mono Medium, Bold, Italic, Bold Italic Courier
Letter Gothic Medium, Bold, Italic, Letter Gothic
Nimbus Mono PS Regular, Bold, Oblique, Bold Courier PS

Oblique
Nimbus Roman No4 Medium, Bold, Italic, Bold Italic CG Times
URW Classico Medium, Bold, Italic, Bold Italic CG Omega
URW Coronet — Coronet
URW Clarendon Condensed — Clarendon Condensed
URW Classic Sans Medium, Bold, Italic, Bold Italic Univers
URW Classic Sans Medium, Bold, Italic, Bold Italic Univers Condensed
Condensed
Antique Olive Medium, Bold, Italic Antique Olive
Garamond Antiqua, Halbfett, Kursiv, Kursiv Garamond

Halbfett
Mauritius — Marigold
Algiers Medium, Extra Bold Albertus
NimbusSansNo2 Medium, Bold, Italic, Bold Italic Arial
Nimbus Roman No9 Medium, Bold, Italic, Bold Italic Times New
Nimbus Sans Medium, Bold, Oblique, Bold Helvetica

Oblique
Nimbus Sans Narrow Medium, Bold, Oblique, Bold Helvetica Narrow

Oblique
Palladio Roman, Bold, Italic, Bold Italic Palatino
URW Gothic Book, Demi, Book Oblique, Demi ITC Avant Garde

Oblique
URW Bookman Light, Demi, Light Italic, Demi ITC Bookman

Italic
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Font name Family HP equivalent
URW Century Schoolbook Roman, Bold, Italic, Bold Italic New Century Schoolbook
Nimbus Roman Medium, Bold, Italic, Bold Italic Times
URW Chancery Medium Italic — ITC Zapf Chancery Italic
Symbol — Symbol
URW Dingbats — Wingdings
Dingbats — ITC Zapf Dingbats
Standard Symbol — SymbolPS

Parent topic: Technical Specifications

PCL Fonts
Scalable Fonts

Font name Family HP equivalent Symbol set
Nimbus Mono Medium, Bold, Italic, Bold Courier 1

Italic
Letter Gothic Regular, Bold, Italic, Letter Gothic 1
Nimbus Mono PS Regular, Bold, Oblique, CourierPS 3

Bold Oblique
Nimbus Roman No4 Medium, Bold, Italic, Bold CG Times 2

Italic
URW Classico Medium, Bold, Italic, Bold CG Omega 3

Italic
URW Coronet — Coronet 3
URW Clarendon — Clarendon Condensed 3
Condensed
URW Classic Sans Medium, Bold, Italic, Bold Univers 2

Italic
URW Classic Sans Medium, Bold, Italic, Bold Univers Condensed 3
Condensed Italic
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Font name Family HP equivalent Symbol set
Antique Olive Medium, Bold, Italic Antique Olive 3
Garamond Antiqua, Halbfett, Kursiv, Garamond 3

Kursiv Halbfett
Mauritius — Marigold 3
Algiers Medium, Extra Bold Albertus 3
NimbusSansNo2 Medium, Bold, Italic, Bold Arial 3

Italic
Nimbus Roman No9 Medium, Bold, Italic, Bold Times New 3

Italic
Nimbus Sans Medium, Bold, Oblique, Helvetica 3

Bold Oblique
Nimbus Sans Narrow Medium, Bold, Oblique, Helvetica Narrow 3

Bold Oblique
Palladio Roman, Bold, Italic, Bold Palatino 3

Italic
URW Gothic Book, Demi, Book ITC Avant Garde 3

Oblique, Demi Oblique
URW Bookman Light, Demi, Light Italic, ITC Bookman 3

Demi Italic
URW Century Roman, Bold, Italic, Bold New Century Schoolbook 3
Schoolbook Italic
Nimbus Roman Medium, Bold, Italic, Bold Times 3

Italic
URW Chancery — ITC Zapf Chancery Italic 3
Medium Italic
Symbol — Symbol 4
URW DingBats — Wingdings 5
Dingbats — ITC Zapf Dingbats 6
Standard Symbol — SymbolPS 4
URW David Medium, Bold HP David 7
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Font name Family HP equivalent Symbol set
URW Narkis Medium, Bold HP Narkis Tam 7
URW Miryam Medium, Bold, Italic HP Miryam 7
URW Koufi Medium, Bold Koufi 8
URW Naskh Medium, Bold Naskh 8
URW Ryadh Medium, Bold Ryadh 8

Bitmap Font
Line Printer, Symbol set 9

OCR/Barcode Bitmap Font (PCL5 Mode Only)

Font name Family Symbol set
OCR A — 10
OCR B — 11
Code 39 9.37cpi, 4.68cpi 12
EAN/UPC Medium, Bold 13

Note: Depending on the print density, or quality and color of the paper, the OCR/Barcode Bitmap fonts
may not be readable. Print a sample and check for readability before printing large quantities.

Parent topic: Technical Specifications

Symbol Sets
Your product can access a variety of symbol sets. Many of these symbol sets differ only in the
international characters specific to each language.

Note: Since most software handles fonts and symbols automatically, you may never need to adjust your
product settings. However, if you write your own product control programs, or if you use older software
that cannot control fonts, refer to these tables for details on the symbol sets.

When you consider which font to use, also consider which symbol set to combine with the font. Available
symbol sets vary depending on the mode and font you choose.
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PCL5 Mode Symbol Sets

Symbol set Attribute Font classification
name 1 2 3 4 5 6 7 8 9 10 11 12 13
ISO 60: 0D — — — — — — — — — —
Danish/Nor
wegian
Roman 0E — — — — — — — — — — — —
Extension
ISO 15: 0I — — — — — — — — — —
Italian
ISO 8859/1 0N — — — — — — — — —
Latin 1
ISO 11: 0S — — — — — — — — — —
Swedish
ISO 6: 0U — — — — — — — —
ASCII
ISO 4: 1E — — — — — — — — — —
United
Kingdom
ISO 69: 1F — — — — — — — — — —
French
ISO 29: 1G — — — — — — — — — —
German
Legal 1U — — — — — — — — —

ISO 8859/2 2N — — — — — — — — —
Latin 2
ISO 8859/4 4N — — — — — — — — — —
Latin 4
ISO 17: 2S — — — — — — — — — —
Spanish
Roman-9 4U — — — — — — — — — —
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Symbol set Attribute Font classification
name 1 2 3 4 5 6 7 8 9 10 11 12 13
PS Math 5M — — — — — — — —

ISO 8859/9 5N — — — — — — — — —
Latin 5
Windows 5T — — — — — — — — — —
3.1 Latin 5
Microsoft 6J — — — — — — — — — —
Publishing
Ventura 6M — — — — — — — — — —
Math
ISO 6N — — — — — — — — —
8859/10
Latin 6
DeskTop 7J — — — — — — — — — —

Math-8 8M — — — — — — — —

Roman-8 8U — — — — — — — — —

Windows 9E — — — — — — — — — —
3.1 Latin 2
Pc1004 9J — — — — — — — — — —

ISO 9N — — — — — — — — —
8859/15
Latin 9
PC-8 9T — — — — — — — — — —
Turkish
Windows 9U — — — — — — — — — —
3.0 Latin 1
PS Text 10J — — — — — — — — — —

PC-8, Code 10U — — — — — — — — —
Page 437

240



Symbol set Attribute Font classification
name 1 2 3 4 5 6 7 8 9 10 11 12 13
PC-8 D/N 11U — — — — — — — — —
Danish/Nor
wegian
MC Text 12J — — — — — — — — — —

PC-850 12U — — — — — — — — —
Multilingual
Ventura 13J — — — — — — — — — —
Internationa
l
PcEur858 13U — — — — — — — — — —

Ventura US 14J — — — — — — — — — —

Pi Font 15U — — — — — — — — — —

PC852, 17U — — — — — — — — — —
Latin 2
Unicode 3.0 18N — — — — — — — —

Windows 19L — — — — — — — — — —
Baltic
Windows 19U — — — — — — — — — —
3.1
Latin/Arabic
PC-755 26U — — — — — — — — — —

PC-866, 3R — — — — — — — — — — —
Cyrillic
Greek8 8G — — — — — — — — — — —

Windows 9G — — — — — — — — — — —
Greek
Windows 9R — — — — — — — — — — —
Cyrillic
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Symbol set Attribute Font classification
name 1 2 3 4 5 6 7 8 9 10 11 12 13
PC-851, 10G — — — — — — — — — — —
Greek
ISO 8859/5 10N — — — — — — — — — —
Cyrillic
PC-8, 12G — — — — — — — — — — —
Greek
ISO 8859/7 12N — — — — — — — — — — —
Greek
PC-866 14R — — — — — — — — — — —
UKR
Hebrew7 0H — — — — — — — — — — —

ISO 8859/8 7H — — — — — — — — — — —
Hebrew
Hebrew8 8H — — — — — — — — — — —

PC-862, 15H — — — — — — — — — — —
Hebrew
PC-862, 15Q — — — — — — — — — — —
Hebrew
Arabic8 8V — — — — — — — — — — — —

HPWARA 9V — — — — — — — — — — — —

PC-864, 10V — — — — — — — — — — — —
Arabic
Wingdings 579L — — — — — — — — — — — —

Symbol 19M — — — — — — — — — — — —

ZapfDigbat 14L — — — — — — — — — — — —
s
OCR A 0O — — — — — — — — — — — —

OCR B 1O — — — — — — — — — — — —
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Symbol set Attribute Font classification
name 1 2 3 4 5 6 7 8 9 10 11 12 13
OCR B 3Q — — — — — — — — — — — —
Extension
Code3-9 0Y — — — — — — — — — — — —

EAN/UPC 8Y — — — — — — — — — — — —

PCL6 Mode Symbol Sets

Symbol set Attribute Font classification
name 1 2 3 4 5 6 7 8 9
ISO Norwegian 4 — — — — — —

ISO Italian 9 — — — — — —

ISO 8859-1 14 — — — — —
Latin 1
ISO Swedish 19 — — — — — —

ASCII 21 — — — —

ISO United 37 — — — — — —
Kingdom
ISO French 38 — — — — — —

ISO German 39 — — — — — —

Legal 53 — — — — —

ISO 8859-2 78 — — — — —
Latin 2
ISO Spanish 83 — — — — — —

Roman-9 149 — — — — — —

PS Math 173 — — —

ISO 8859-9 174 — — — — —
Latin 5
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Symbol set Attribute Font classification
name 1 2 3 4 5 6 7 8 9
Windows 3.1 180 — — — — — —
Latin 5
Microsoft 202 — — — — — —
Publishing
ISO 8859/10 206 — — — — —
Latin 6
DeskTop 234 — — — — — —

Math-8 269 — — —

Roman-8 277 — — — — —

Windows 3.1 293 — — — — — —
Latin 2
Pc1004 298 — — — — — —

ISO 8859-15 302 — — — — —
Latin 9
PC-Turkish 308 — — — — — —

Windows 3.0 309 — — — — — —

PS Text 330 — — — — — —

PC-8 341 — — — — —

PC-8 D/N 373 — — — — —

MC Text 394 — — — — — —

PC-850 405 — — — — —

PcEur858 437 — — — — — —

Pi Font 501 — — — — — —

PC852 565 — — — — — —

Unicode 3.0 590 — — — —

WBALT 620 — — — — — —
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Symbol set Attribute Font classification
name 1 2 3 4 5 6 7 8 9
Windows 3.1 629 — — — — — —
Latin 1
PC-755 853 — — — — — —

Wingdings 18540 — — — — — — — —

Symbol 621 — — — — — — — —

ZapfDingbats 460 — — — — — — — —

PC-866, 114 — — — — — — —
Cyrillic
Greek8 263 — — — — — — —

Windows 295 — — — — — — —
Greek
Windows 306 — — — — — — —
Cyrillic
PC-851, Greek 327 — — — — — — —

ISO 8859/5 334 — — — — — — —
Cyrillic
PC-8, Greek 391 — — — — — — —

ISO 8859/7 398 — — — — — — —
Greek
PC-866 UKR 466 — — — — — — —

Hebrew7 8 — — — — — — —

ISO 8859/8 232 — — — — — — —
Hebrew
Hebrew8 264 — — — — — — —

PC-862, 488 — — — — — — —
Hebrew
Arabic8 278 — — — — — — — —
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Symbol set Attribute Font classification
name 1 2 3 4 5 6 7 8 9
HPWARA 310 — — — — — — — —

PC-864, Arabic 342 — — — — — — — —

Parent topic: Technical Specifications
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Notices
Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site for
information on how to return your Epson products for proper disposal.

General Printer Safety Instructions
FCC Compliance Statement
Trademarks
Copyright Notice

General Printer Safety Instructions
• Be sure to follow all warnings and instructions marked on the printer.
• Use only the type of power source indicated on the printer's label.
• Use only the power cord that comes with the printer. Use of another cord may cause fires or shock. Do

not use the cord with any other equipment.
• Make sure the AC power cord meets the relevant local safety standard.
• Place the printer near a wall outlet where the plug can be easily unplugged.
• Avoid plugging the printer into an outlet on the same circuit as a photo copier or air control system that

regularly switches on and off, or on an outlet controlled by a wall switch or timer.
• Do not let the power cord become damaged or frayed.
• If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged

into the extension cord does not exceed the cord's ampere rating. Also, make sure the total ampere
rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.

• Always turn off the printer using the power button, and wait until the power light stops flashing before
unplugging the printer or cutting off power to the electrical outlet.

• Place the printer on a flat, stable surface that extends beyond its base in all directions. It will not
operate properly if it is tilted or at an angle.

• Make sure the back of the printer is at least 4 inches (10 cm) away from the wall.
• Leave enough space in front of the printer for the paper to be fully ejected.
• Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
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• Do not place the printer near a radiator or heating vent or in direct sunlight.
• Leave enough room around the printer for sufficient ventilation. Do not block or cover openings in the

case or insert objects through the slots.
• Keep the printer away from potential sources of electromagnetic interference, such as loudspeakers or

the base units of cordless telephones.
• Do not touch the flat white cable inside the printer.
• Do not move the print head by hand; this may damage the printer.
• Do not spill liquid on the printer and do not handle the printer with wet hands.
• Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may

cause fire.
• Except as specifically explained in your documentation, do not attempt to service the printer yourself.
• Unplug the printer and refer servicing to qualified service personnel under the following conditions: if

the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped
or the case damaged; if the product does not operate normally or exhibits a distinct change in
performance. Adjust only those controls that are covered by the operating instructions.

• If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are fuses in
the plug, make sure you replace them with fuses of the correct size and rating.

• Unplug the power cord from the electrical outlet if you are not going to use the printer for an extended
period.

• Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may
prevent the printer from printing.

• Before transporting the printer, make sure that the print head is in the home (far right) position and the
ink cartridges are in place.

• When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside down;
otherwise ink may leak.

Ink Cartridge Safety Instructions
LCD Screen Safety Instructions
Wireless Connection Safety Instructions
Parent topic: Notices

Ink Cartridge Safety Instructions
• Keep ink cartridges out of the reach of children and do not drink the ink.
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• Keep the maintenance box out of the reach of children.
• Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply

port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them
immediately with water.

• Do not put your hand inside the product or touch any cartridges during printing.
• Install a new ink cartridge immediately after removing an expended one. Leaving cartridges

uninstalled can dry out the print head and may prevent the product from printing.
• Do not touch the green IC chip on the side of the cartridge. This may prevent normal operation.
• Do not shake cartridges after opening their packages; this can cause them to leak.
• If you remove an ink cartridge for later use, recap the ink cartridge using the cap that came with it to

prevent the ink from drying out and to protect the surrounding area from getting smeared by ink.
• Use an ink cartridge before the date printed on its package.
• Do not dismantle an ink cartridge. This could damage the print head.
• Do not disassemble the ink cartridges or maintenance box; you may get ink in your eyes or on your

skin.
• Store ink cartridges in a cool, dark place.
• After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature

for at least three hours before using it.
Parent topic: General Printer Safety Instructions

LCD Screen Safety Instructions
• Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.
• If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash

them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them
immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor
immediately.

• Do not press too hard on the LCD screen.
• Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.
Parent topic: General Printer Safety Instructions
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Wireless Connection Safety Instructions
Radio waves from this product may adversely affect the operation of medical equipment or automatically
controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near
such devices or inside a medical facility, follow the directions from authorized staff members at the
facility, and follow all posted warnings and directions on the device to avoid causing an accident.
Parent topic: General Printer Safety Instructions

FCC Compliance Statement
For United States Users
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
CAN ICES-3(B)/NMB-3(B)
Parent topic: Notices
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Trademarks
EPSON® is a registered trademark, EPSON Exceed Your Vision is a registered logomark, and Epson
ConnectTM is a trademark of Seiko Epson Corporation.
Epson StoreSM is a service mark of Epson America, Inc.
Epson iPrintTM and Remote PrintTM are trademarks of Seiko Epson Corporation.
Mac and OS X are trademarks of Apple Inc., registered in the U.S. and other countries. AirPrint and the
AirPrint logo are trademarks of Apple Inc.
Google® is a registered trademark and AndroidTM, ChromebookTM, and Google Cloud PrintTM are
trademarks of Google Inc.
Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.
General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Parent topic: Notices

Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.
Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.
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Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.
This information is subject to change without notice.
A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution
Parent topic: Notices

A Note Concerning Responsible Use of Copyrighted Materials
Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.
Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products
This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets
Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.
Parent topic: Copyright Notice

Copyright Attribution
© 2015 Epson America, Inc.
10/15
CPD-42747R1
Parent topic: Copyright Notice
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